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C H A P T E R 7

Create Circuits and Provisionable Patchcords

This chapter explains how to create Cisco ONS 15454 dense wavelength division multiplexing (DWDM) 
optical channel client connections (OCHCCs), optical channel network connections (OCHNCs), optical 
trail circuits, and STS circuits. The chapter also tells you how to create provisionable patchcords, 
upgrade OCHNCs to OCHCCs, manage SVLANs for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards, and manage overhead circuits.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G151 Create, Delete, and Manage Optical Channel Client Connections, page 7-2—Complete 
as needed.

2. NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 7-16—Complete as needed.

3. NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, 
page 7-21—Complete as needed.

4. NTP-G200 Create, Delete, and Manage STS or VC Circuits for the ADM-10G Card, 
page 7-29—Complete as needed.

5. NTP-G150 Upgrade Optical Channel Network Connections to Optical Channel Client Connections, 
page 7-40—Complete as needed.

6. NTP-G183 Diagnose and Fix OCHNC and OCH Trail Circuits, page 7-45—Complete as needed to 
verify all conditions are valid before placing OCHNC or OCH trail circuits in service.

7. NTP-G58 Locate and View Optical Channel Circuits, page 7-47—Complete as needed to find, view, 
and filter OCHCC, OCHNC, and OCH trail circuits.

8. NTP-G184 Create a Provisionable Patchcord, page 7-54—Complete as needed.

9. NTP-G181 Manage GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card SVLAN Databases, 
page 7-60—Complete as needed.

10. NTP-G60 Create and Delete Overhead Circuits, page 7-63—Complete as needed to create 
IP-encapsulated tunnels, firewall tunnels, and proxy tunnels; to create generic communications 
channel (GCC) terminations; to provision orderwire; or to create user data channel (UDC) circuits.
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11. NTP-G62 Create a J0 Section Trace, page 7-71—Complete as needed to monitor interruptions or 
changes to traffic between two nodes.

12. NTP-G203 Create End-to-End SVLAN Circuits, page 7-72—Complete as needed to create end to 
end VLAN circuits.

13. NTP-G229 Provision DCN Extension for a Network Using GCC/DCC, page 7-75—Complete as 
needed to provision DCN extension for a network using GCC/DCC.

NTP-G151 Create, Delete, and Manage Optical Channel Client 
Connections

Note This procedure is not applicable to the ADM-10G card or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards that are not provisioned in L2 over DWDM mode.

Step 1 As needed, identify the OCHCC to be provisioned using the “DLP-G350 Use the Cisco TransportPlanner 
Traffic Matrix Report” task on page 6-26.

Step 2 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you want to 
manage OCHCCs. If you are already logged in, continue with Step 3.

Step 3 If you want to assign a name to the OCHCC source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 7-3. If not, continue with Step 4.

Note Naming the client ports helps you identify them correctly later.

Purpose This procedure creates, deletes, and manages OCHCC circuits. OCHCCs 
create an end-to-end optical management path between TXP, MXP, 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE (when provisioned as TXPs 
or MXPs), or OTU2_XP client ports, or between ITU-T trunk ports. ITU-T 
line cards include: OC48 ELR/STM64 EH, OC192 SR1/STM64 IO, 
MRC-12, MRC-2.5-12, and MRC-2.5G-4. The OCHCC circuit is 
transported by an OCH trail circuit that is associated to one or more 
OCHNC circuits (for example, an OCHCC circuit passing through a regen

node). 

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
7-2
Cisco ONS 15454 DWDM Procedure Guide, R9.0

78-18376-02



 

Chapter 7      Create Circuits and Provisionable Patchcords
DLP- G104 Assign a Name to a Port
Step 4 If the client TXP, MXP, or ITU-T line cards are installed in a multishelf node, continue with Step 5. If 
not, complete the following substeps:

a. Use the information obtained from the Cisco TransportPlanner traffic matrix report in Step 1 to 
complete the “DLP-G344 Verify Provisionable and Internal Patchcords” task on page 7-43. If 
provisionable patchcords (PPCs) exist between the nodes containing the TXP/MXP/ITU-T line 
cards and the DWDM nodes at each end of the OCHCC, continue with Step 5. If not, continue with 
Step b.

b. Complete the “NTP-G184 Create a Provisionable Patchcord” task on page 7-54 to create the PPCs 
between the OCHCC source and destination nodes. 

Step 5 If the client TXP/MXP/ITU-T line cards are installed in a multishelf node, use the information obtained 
from the Cisco TransportPlanner traffic matrix report in Step 1 to create internal patchcords between the 
32DMX, 32DMX-O, or 32DMX-L ports and the TXP/MXP trunk ports using the “DLP-G354 Create an 
Internal Patchcord Manually” task on page 3-100. Create the internal patchcords on both the source and 
destination nodes of each OCHCC path. If the TXP/MXP/ITU-T line cards are not installed in a 
multishelf node, continue with Step 6.

Step 6 Complete the “DLP-G345 Verify OCHCC Client Ports” task on page 7-4 to verify the port rate and 
service state.

Step 7 Complete the “DLP-G346 Provision Optical Channel Client Connections” task on page 7-4, as needed.

Step 8 Complete the “DLP-G689 Provision Optical Channel Client Connections on OTU2_XP Cards” task on 
page 7-11, as needed.

Step 9 Complete the “DLP-G347 Delete Optical Channel Client Connections” task on page 7-11, as needed.

Step 10 Complete the “DLP-G424 Edit an OCHCC Circuit Name” task on page 7-13, as needed.

Step 11 Complete the “DLP-G394 Change an OCHCC Administrative State” task on page 7-13, as needed.

Stop. You have completed this procedure.

DLP-G104 Assign a Name to a Port

Step 1 In node view, double-click the card that has the port that you want to provision. This can be any port on 
a traffic-carrying card. The card view opens.

Step 2 Click the Provisioning tab.

Step 3 Double-click the Port Name table cell for the port number where you are assigning a name. The cell 
activates and a blinking cursor indicates where you should enter the port name.

Step 4 Enter the port name. 

The port name can be up to 32 alphanumeric/special characters. The field is blank by default.

Purpose This task assigns a name to a port on any ONS 15454 card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G345 Verify OCHCC Client Ports

Step 1 In node view, double-click the TXP, MXP, OTU2_XP, or ITU-T line card where you want to verify the 
client ports. The card view opens. 

Step 2 Click the Provisioning > Maintenance tabs.

Step 3 Click the Provisioning > Pluggable Port Modules tabs.

Step 4 Verify that a pluggable port module has been created and that the port rate under the Pluggable Port area 
is provisioned. If so, continue with Step 5. If not, complete the “DLP-G277 Provision a Multirate PPM” 
task on page 5-10 and the “DLP-G278 Provision the Optical Line Rate” task on page 5-13.

Step 5 Repeat Steps 1 through 4 for each TXP, MXP, OTU2_XP, or ITU-T line card containing OCHCC ports 
that you want to verify.

Step 6 Return to your originating procedure (NTP).

DLP-G346 Provision Optical Channel Client Connections

Note OCHCCs can be created on preprovisioned client cards or physically installed client cards.

Purpose This task verifies the rate and service state of the OCHCC client ports.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task creates an OCHCC between two TXP, MXP, GE_XP and 
GE_XPE (when configured in TXP or MXP mode), 10GE_XP and 
10GE_XPE (when configured in TXP or MXP mode), or OTU2_XP client 
ports, or two ITU-T-compliant line card trunk ports. 

Tools/Equipment Cisco TransportPlanner Traffic Matrix Report

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

DLP-G345 Verify OCHCC Client Ports, page 7-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note If you want the OCHCC circuit to provision the client card trunk port’s ITU-T G.709, FEC, SD and SF 
threshold settings and Mapping parameters, you must place the client card trunk ports out of service. 

Note Creating an OCHCC circuit automatically creates an OCH trail circuit between the OCHCC source and 
destination client card trunk ports. The OCH trail circuit is created for the first OCHCC between two 
MXP cards. The OCH trail circuit is used by succeeding OCHCCs created between the MXP cards. 
When the OCH trail is created, it is assigned a system-generated name in the format 
circuit-type_NE-name::unique sequence number. To edit the OCH trail circuit name, complete the 
“DLP-G424 Edit an OCHCC Circuit Name” task on page 7-13.

Note If trunk ports are connected by a peer-to-peer provisionable patchcord (PPC), an OCH trail is not created.

Note The OCH Wlen (wavelength) parameter on the Circuits page can be used to determine the OCHCC and 
OCH trail associations.

Note In a node using OTU2_XP cards configured in the regen mode, a single OCHCC circuit can be created 
that passes through the OTU2_XP card. Internal patch cords must be created from the OTU2_XP regen 
ports to the respective add/drop cards. OCHCC circuit creation through OTU2_XP cards in regen mode 
is not supported if different wavelengths are used on the two OTU2_XP regen ports.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHCC from the Circuit Type list. 

Step 4 Click Next.

Step 5 In the Circuit area of the Circuit Attributes page (Figure 7-1 on page 7-9), provision the OCHCC circuit 
attributes:

• Name—Assign a name to the OCHCC. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, Cisco Transport Controller (CTC) assigns a default 
name to the circuit.

• Type—(Display only) OCHCC.

• Size—Defines the circuit payload type and rate. Two fields are provided. The first specifies the 
payload type. Choose a payload type, then choose the rate in the next field. Table 7-1 provides the 
OCHCC payload types and rates.

Note The payload type and rate must match the PPM provisioning on the client cards at the source 
and destination nodes. 
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• OCHNC Wavelength—Provides three fields to define the wavelength that the OCHCC will use to 
travel across the OCH network. Choose a wavelength from the first field. In the second field, you 
can change the wavelength band by choosing either C Band or L Band. In the third field, you can 
indicate whether odd or even C-band or L-band wavelengths appear. See Table 7-2 and Table 7-3 for 
C-band and L-band wavelengths.

Note The OCHNC wavelength must match the trunk wavelength provisioned on the source and 
destination TXP or MXP cards. If the wavelengths do not match, the card will not appear as 
a source or destination.

Table 7-1 OCHCC Client Rates

Payload Type Rates

SONET/SDH OC-192 (ANSI)/STM-64 (ETSI)—9.92 Gbps

OC-48 (ANSI)/STM-12 (ETSI)—2.48 Gbps

OC-12 (ANSI)/STM-4 (ETSI)—622 Mbps

OC-3 (ANSI)/STM-1 (ETSI)—155 Mbps

Ethernet 10GE—One Gigabit Ethernet 11.25 Gbps

1GE—One Gigabit Ethernet 1.125 Gbps

FC/FICON 10GFC—Fibre Channel 10 Gbps 

4GFC—Fibre Channel 4 Gbps 

2GFC—Fibre Channel 2.125 Gbps

1GFC—Fibre Channel 1.06 Gbps

4GFICON—FICON 4 Gbps 

2GFICON—FICON 2.125 Gbps 

1GFICON—FICON 1.06 Gbps 

Data Storage ESCON—Enterprise System Connection 200 Mbps (IBM signal)

ISC Peer—InterSystem Coupling Link 3 (ISC3)

ISC3 Peer 1G—InterSystem Coupling Link 3 (ISC3) 1 Gbps

ISC3 Peer 2G—InterSystem Coupling Link 3 (ISC3) 2 Gbps

ISC COMPAT—InterSystem Coupling Link 1 (ISC1)

Video HDTV—High Definition Television

SDI/DI—Serial Digital Interface and Digital Video signal type 1

DV6000—Proprietary signal from video vendor

Other Pass Through—Creates a pass-through OCHCC
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Table 7-2 OCH C-Band Channels

Channel No. Channel ID Frequency (GHz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.1 195.8 1531.12

3 31.9 195.7 1531.90

4 33.4 195.5 1532.68

5 32.6 195.6 1533.471

6 34.2 195.4 1534.25

7 35.0 195.3 1535.04

8 35.8 195.2 1535.82

9 36.1 195.1 1536.61

10 37.4 195 1537.401

11 38.1 194.9 1538.19

12 38.9 194.8 1538.98

13 39.7 194.7 1539.77

14 40.5 194.6 1540.56

15 41.3 194.5 1541.351

16 42.1 194.4 1542.14

17 42.9 194.3 1542.94

18 43.7 194.2 1543.73

19 44.5 194.1 1544.53

20 44.3 194 1545.321

21 46.1 193.9 1546.12

22 46.9 193.8 1546.92

23 47.7 193.7 1547.72

24 48.5 193.6 1548.51

25 49.3 193.5 1549.321

26 50.1 193.4 1550.12

27 50.9 193.3 1550.92

28 51.7 193.2 1551.72

29 52.5 193.1 1552.52

30 53.3 193 1553.331

31 54.1 192.9 1554.13

32 54.9 192.8 1544.94

33 55.7 192.7 1555.75

34 56.5 192.6 1556.55

35 57.3 192.5 1557.361

36 58.1 192.4 1558.17
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37 58.9 192.3 1558.98

38 59.7 192.2 1559.79

39 60.6 192.1 1560.61

40 61.3 192 1561.421

1. Requires 40-channel MUX or WSS cards, and 40-channel DMX cards.

Table 7-3 OCH L-Band Channels

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 190.85 1570.83 41 188.85 1587.46

2 190.8 1571.24 42 188.8 1587.88

3 190.75 1571.65 43 188.75 1588.30

4 190.7 1572.06 44 188.7 1588.73

5 190.65 1572.48 45 188.65 1589.15

6 190.6 1572.89 46 188.6 1589.57

7 190.55 1573.30 47 188.55 1589.99

8 190.5 1573.71 48 188.5 1590.41

9 190.45 1574.13 49 188.45 1590.83

10 190.4 1574.54 50 188.4 1591.26

11 190.35 1574.95 51 188.35 1591.68

12 190.3 1575.37 52 188.3 1592.10

13 190.25 1575.78 53 188.25 1592.52

14 190.2 1576.20 54 188.2 1592.95

15 190.15 1576.61 55 188.15 1593.37

16 190.1 1577.03 56 188.1 1593.79

17 190.05 1577.44 57 188.05 1594.22

18 190 1577.86 58 188 1594.64

19 189.95 1578.27 59 187.95 1595.06

20 189.9 1578.69 60 187.9 1595.49

21 189.85 1579.10 61 187.85 1595.91

22 189.8 1579.52 62 187.8 1596.34

23 189.75 1579.93 63 187.75 1596.76

24 189.7 1580.35 64 187.7 1597.19

25 189.65 1580.77 65 187.65 1597.62

26 189.6 1581.18 66 187.6 1598.04

27 189.55 1581.60 67 187.55 1598.47

Table 7-2 OCH C-Band Channels (continued)

Channel No. Channel ID Frequency (GHz) Wavelength (nm)
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• Bidirectional—(Display only) OCHCCs are bidirectional. This field cannot be changed.

• Protection—Check to create a splitter-protected OCHCC (only MXPP/TXPP cards will be 
selectable as circuit endpoints) or a protected OCHCC when TXP is connected to a PSM card.

Figure 7-1 OCHCC Attributes Page

Step 6 In the State area of the Circuit Attributes page, provision the OCHCC state attributes:

• State—Provisions the OCHCC circuit state. The state can be IS (ANSI)/Unlocked (ETSI) or 
OOS,DSBLD (ANSI)/Locked,Disabled (ETSI). 

• Apply to OCHCC ports—If checked, applies the state chosen in the Apply to OCHCC ports 
drop-down list to the OCHCC client ports. For TXP, MXP, TXPP, or MXPP cards, the administrative 
state will apply to the client and all trunk ports. For ITU-T-compliant line cards, the administrative 

28 189.5 1582.02 68 187.5 1598.89

29 189.45 1582.44 69 187.45 1599.32

30 189.4 1582.85 70 187.4 1599.75

31 189.35 1583.27 71 187.35 1600.17

32 189.3 1583.69 72 187.3 1600.60

33 189.25 1584.11 73 187.25 1601.03

34 189.2 1584.53 74 187.2 1601.46

35 189.15 1584.95 75 187.15 1601.88

36 189.1 1585.36 76 187.1 1602.31

37 189.05 1585.78 77 187.05 1602.74

38 189 1586.20 78 187 1603.17

39 188.95 1586.62 79 186.95 1603.60

40 188.9 1587.04 80 186.9 1604.03

Table 7-3 OCH L-Band Channels (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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state will apply to the trunk port only. The states that you can apply include: 
IS (ANSI)/Unlocked (ETSI), OOS,DSBLD (ANSI)/Locked,Disabled (ETSI), and 
IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI).

Step 7 Click Next. 

Step 8 In the Source area, choose the source node from the Node drop-down list, then choose the source shelf 
(multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, and, 
if needed, the source port from the Port drop-down list. 

If no nodes appear in the Node drop-down list, complete the following steps: 

a. Click Back and review your circuit attribute settings. Verify that they are set to the client attributes 
provisioned on the client cards. If necessary, click Cancel and complete the “DLP-G345 Verify 
OCHCC Client Ports” task on page 7-4 to verify the client settings.

b. If the source and/or destination nodes are not configured for multishelf, complete the “DLP-G344 
Verify Provisionable and Internal Patchcords” task on page 7-43 to verify that the patchcords were 
created accurately.

If these steps do not solve the problem, refer to your next level of support.

Step 9 Click Next. 

Step 10 In the Destination area, choose the destination node from the Node drop-down list, then choose the 
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot 
drop-down list, and, if needed, the destination port from the Port drop-down list. 

If no nodes appear in the Node drop-down list, complete the following steps: 

a. Click Back and review your circuit attribute settings. Verify that they are set to the client attributes 
provisioned on the client cards. If necessary, click Cancel and complete the “DLP-G345 Verify 
OCHCC Client Ports” task on page 7-4 to verify the client settings.

b. If the source and/or destination nodes are not configured for multishelf, complete the “DLP-G344 
Verify Provisionable and Internal Patchcords” task on page 7-43 to verify that the patchcords were 
created accurately.

If these steps do not solve the problem, refer to your next level of support.

Step 11 Click Next. If the OCHCC is between ITU-T cards, continue with Step 12. If not, skip to Step 14.

Step 12 Complete the “DLP-G437 Set OCH Circuit Attributes” task on page 7-14.

Step 13 Click Next. 

Step 14 Complete the “DLP-G438 Set OCH Routing Preferences” task on page 7-15. Skip this step and continue 
with Step 15 if no constraints are needed. If the trunk ports are already connected by an existing OCH 
Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in 
read-only mode; all buttons are disabled. Continue with Step 15.

Step 15 Click Finish. The OCHCC and its OCH trail appear in the Circuits page. After the circuit status has been 
verified, the DISCOVERED status appears in the Status column.

If the OCHCC status does not change to DISCOVERED within 2 to 3 minutes, contact your next level 
of support.

Step 16 Return to your originating procedure (NTP).
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DLP-G689 Provision Optical Channel Client Connections on OTU2_XP Cards

Step 1 Create an OCHCC circuit between two OTU2_XP ports using the  “DLP-G346 Provision Optical 
Channel Client Connections” task on page 7-4. Set the mapping option to Synchronous during OCHCC 
circuit creation.

Step 2 Change the  administrative state of the OTU2_XP trunk port to  OOS,DSBLD (ANSI) or 
Locked,disabled (ETSI)  at both end points of the circuit using the  “DLP-G108 Change the Service 
State for a Port” task on page 7-67.

Step 3 Enable the OTN line setting "No Fixed Stuff" using the  “DLP-G458 Change the OTU2_XP OTN 
Settings” task on page 5-199.

Step 4 Change the administrative state of the OTU2_XP trunk port to IS (ANSI) or Unlocked (ETSI)  at both 
end points of the circuit using  the “DLP-G108 Change the Service State for a Port” task on page 7-67.

Step 5 Return to your originating procedure (NTP).

DLP-G347 Delete Optical Channel Client Connections

Note If you are deleting more than half of all the active OCHCCs, Cisco recommends that you delete them 
two at a time to allow for proper power compensation. You do not need to delete the active OCHCCs two 
at a time if you are deleting all them.

Step 1 Complete the “NTP-G103 Back Up the Database” procedure on page 13-2 to preserve existing settings 
and, if you will recreate the circuits, record the circuit information.

Step 2 Consult your network operations center (NOC) or other appropriate personnel to verify that the OCHCC 
can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the OCHCC deletion. 

Purpose This task provisions an OCHCC circuit between two OTU2_XP cards 
configured in the transponder mode  carrying 10G Ethernet payload. 

Tools/Equipment Cisco TransportPlanner Traffic Matrix Report

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task deletes DWDM OCHCC circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 From the View menu, choose Go to Network View. 

Step 5 Click the Circuits tab.

Step 6 Under the Type column, choose one or more OCHCCs that you want to delete, then click Delete.

Step 7 In the Delete Circuits confirmation dialog box, complete the following: 

• Change drop port admin state—Check this box if you want to change the circuit source and 
destination port administrative state. After checking the box, choose one of the following 
administrative states: 

– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.

– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in 
service.

– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and 
disables them.

– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for 
maintenance.

• Notify when completed—If checked, the CTC Alerts confirmation dialog box notifies you when the 
OCHCC is deleted. During this time, you cannot perform other CTC functions. If you are deleting 
many OCHCCs, waiting for confirmation might take a few minutes. Circuits are deleted whether or 
not this check box is checked.

Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, 
see the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on 
page 2-33. If the CTC Alerts dialog box is not set to open automatically, the red triangle 
inside the CTC Alerts toolbar icon indicates that a notification exists. 

Step 8 Complete one of the following:

• If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the 
information, continue with Step 9. If you do not want to save the information, continue with Step 10.

• If you did not check Notify when completed, the Circuits page appears. Continue with Step 11.

Step 9 If you want to save the information in the CTC Alerts dialog box, complete the following substeps. If 
you do not want to save it, continue with Step 11.

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a TXT file extension, and click OK.

Step 10 Click Close to close the CTC Alerts dialog box. 

Step 11 Complete the “NTP-G103 Back Up the Database” procedure on page 13-2 if you require a backup of 
your changes.

Step 12 Return to your originating procedure (NTP).
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DLP-G424 Edit an OCHCC Circuit Name

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab.

Step 3 Click the OCHCC whose name you want to edit, then click Edit. The Edit Circuit dialog box appears 
with the General tab displayed.

Step 4 In the Name field, enter the new OCHCC circuit name. 

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G394 Change an OCHCC Administrative State

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Circuits tab.

Step 3 Click the OCHCC that has the administrative state you want to change, then click Edit.

Step 4 In the Edit Circuit dialog box, click the State tab.

Step 5 Click the cell in the Admin State column for the card you want to change, and choose an administrative 
state from the drop-down list:

• IS (ANSI) or Unlocked (ETSI)

• OOS (ANSI) or Locked (ETSI)

Step 6 Click Apply.

Purpose This task changes the name of an OCHCC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 7-23

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the administrative state of an OCHCC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G346 Provision Optical Channel Client Connections, page 7-4

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 If you are changing the OCHCC state to OOS/Locked, click OK on the confirmation dialog. (No 
confirmation dialog appears when placing OCHCCs in service.)

Note For information about the OCH circuit state transitions, refer to the “Administrative and Service States” 
appendix in the Cisco ONS 15454 DWDM Reference Manual.

Step 8 Return to your originating procedure (NTP). 

DLP-G437 Set OCH Circuit Attributes

Step 1 In the OCH Circuit Attributes Preferences page, change the trunk settings as necessary. The settings 
provisioned here can only be provisioned on the ports when the ports are out of service. If the ports are 
in service, these parameters must be the same as the source and destination card ports. If not, the OCHCC 
cannot be created. You can view the current trunk settings (display only) in the Current Values area. 

• To change any of the trunk settings, complete the following in the Provisioning Values area:

– ITU-T G.709 OTN—Choose Enable or Disable to set or disable the IEEE G.709 monitoring on 
the optical transport network. If the OCHCC source or destination is an MXP_2.5G_10E, 
MXP_2.5G_10E_C, or MXP_2.5G_10E_L card, the ITU-T G.709 OTN parameter must always 
be checked. If ITU-T G.709 OTN is checked, the MXP_MR_2.5G and MXPP_MR_2.5G cards 
will not appear as OCHCC source and destination options.

– FEC—Choose the type of FEC: Disabled, Standard, or Enhanced. The options that appear 
depend on the card type. 

– SD BER—Choose the signal degrade bit error rate. 

– Mapping—Sets the mapping for the TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, 
MXP_MR_10DME_C, and MXP_MR_DME_L cards: Not Used, ODU Multiplex (client 
SONET/SDH payload), Asynchronous, or Synchronous. The choices available depend on the 
card. If you set mapping to Synchronous, the client signal is mapped into the OTU2 signal 
without justification of the payload because the client signal timing (the timing source) is the 
same as the trunk output timing. If you set mapping to Asynchronous, the trunk timing is 
disconnected from the client timing (because the network element [NE] is the timing source), 
so justification is needed to map the client signal (OC192/STM64) to OTU2 trunk output.

Note When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A 
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is necessary to provision 
a 4xOC-48 OCHCC circuit.

Purpose This task provisions OCH trunk attributes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

The OCH Circuit Attributes page must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note If the OCHCC source or destination is an MXP_2.5G_10E, MXP_2.5G_10E_C, or 
MXP_2.5G_10E_L card, the Mapping parameter must always be set to Synch.

• Set the protection in the Protection area, as needed. The fields in the Protection area are disabled if 
the OCHCC is not protected and for OCH Trails.

– Revertive—If checked, traffic reverts to the working card after failure conditions remain 
corrected for the amount of time entered in the Reversion Time field. 

– Reversion Time—Sets the reversion time when Revertive is checked. The range is 0.5 to 12.0 
minutes. The default is 5.0 minutes. Reversion time is the amount of time that will elapse before 
the traffic reverts to the working card after conditions causing the switch are cleared. 

Step 2 Return to your originating procedure (NTP).

DLP-G438 Set OCH Routing Preferences

Step 1 In the OCH Circuit Routing Preferences page, view the circuit route. The new OCH appears with blue 
span arrows. Moving your cursor over the arrow displays span information including source, destination, 
and span loss. Complete the following steps to manually provision the routing constraints.

a. In the circuit map area, click a node that you want to include or exclude from the circuit route.

b. Click Include or Exclude. The node name will appear under the Included nodes or Excluded nodes 
list. Include and Exclude cannot be applied to source or destination nodes.

c. Repeat Steps a and b until the circuit routing constraints are complete. To remove a node from the 
Included nodes or Excluded nodes list, click the node in the list and click Remove. To move a node 
up or down in the routing sequence, click the node in the list and click Up or Down.

Note Use the Reset button as needed to clear the constraints and set the default routing.

d. To force the circuit route through specific links, click Advanced. Select the sides where the circuit 
must cross this node and click OK:

– No Side Constraints—Uncheck. 

– Side In—Choose the first side from the drop-down list.

– Side Out—Choose the second side from the drop-down list.

Purpose This task provisions OCH routing preferences.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

The OCH Circuit Routing Preferences page must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
7-15
Cisco ONS 15454 DWDM Procedure Guide, R9.0

78-18376-02



 

Chapter 7      Create Circuits and Provisionable Patchcords
NTP- G178 Create, Delete, and Manage Optical Channel Trails
Note All forced links appear in yellow.

e. Click Apply. CTC verifies the circuit route. If the route is valid, a “Routing evaluation succeeded.” 
message appears. If this message appears, click OK. If the route is not valid, a Route Error dialog 
box appears with an error message. If an error message appears, evaluate the error, click Close to 
close the error dialog box and repeat Steps a through e until the circuit route is successfully 
validated.

f. If the OCHCC is protected, repeat Steps a through e for the protect trunk ports.

Step 2 Return to your originating procedure (NTP).

NTP-G178 Create, Delete, and Manage Optical Channel Trails

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you want to 
manage OCHNCs. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the OCHNC source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 7-3. If not, continue with the next step.

Step 3 Complete the “DLP-G395 Create an Optical Channel Trail” task on page 7-17, as needed, between 
ADM-10G cards or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards that are provisioned in L2 over 
DWDM mode.

Step 4 Complete the “DLP-G418 Delete an Optical Channel Trail” task on page 7-19, as needed.

Step 5 Complete the “DLP-G425 Edit an OCH Trail Circuit Name” task on page 7-20, as needed.

Step 6 Complete the “DLP-G419 Change an OCH Trail Administrative State” task on page 7-21, as needed.

Stop. You have completed this procedure.

Purpose This procedure creates and deletes DWDM OCH trail circuits and changes 
their administrative states.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G395 Create an Optical Channel Trail

Note OCH trail circuits are created automatically when you provision OCHCC circuits between TXP and 
MXP cards.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHTRAIL from the Circuit Type list. 

Step 4 Click Next.

Step 5 In the Circuit area of the Circuit Attributes page, provision the OCH trail circuit attributes (Figure 7-2):

• Name—Assign a name to the OCH trail. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—(Display only) OCHTRAIL.

• Size—(Display only) Equipped non specific is the default.

• OCHNC Wavelength—Choose a band (either C Band or L Band) in the lower drop-down list. Then, 
choose the OCHNC wavelength that you want to assign to the OCH trail circuit in the upper 
drop-down list. See Table 7-2 on page 7-7 and Table 7-3 on page 7-8 for C-band and L-band 
wavelengths.

• Bidirectional—This parameter does not apply to OCH trail circuits.

• State—Provision the OCH trail circuit state. The state can be IS,AINS 
(ANSI)/Unlocked automatic inservice (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).

• Apply to trunk ports—Check this box if you want to provision the administrative state of the OCH 
trail trunk ports. If checked, choose the state in the next field, either IS (ANSI)/Unlocked (ETSI) or 
OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).

Purpose This task creates an OCH trail circuit between ADM-10G cards, CRS-1 
routers, or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards when 
provisioned in L2-over-DWDM mode.

For OCH trails connecting ADM-10G cards, the OCH trail provides the 
low-layer path to route STS or VC circuits over ADM-10G cards.

For OCH trails connecting GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards in L2-over-DWDM mode, the OCH trail provides the links 
associated to the SVLAN entities.

For OCH trails connecting CRS-1 routers, the OCH trail provides 
end-to-end circuit connectivity between the CRS-1 routers passing through 
an MSTP network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 7-2 OCH Trail Attributes Page

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source 
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, 
and, if needed, the source port from the Port drop-down list. For most cards, the port will be 
automatically chosen.

If you are creating an OCH trail circuit between CRS-1 routers, choose the source CRS-1 router from 
the Node drop-down list. The Shelf, Slot, and Port fields are not available. CTC automatically selects 
the PLIM port depending on the OCHNC Wavelength value specified in Step 5.

The source In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 8 Click Next. 

Step 9 In the Circuit Destination area, choose the destination node from the Node drop-down list (only the 
source node will be available because the source and destination nodes are the same), then choose the 
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot 
drop-down list, and, if needed, the destination port from Port drop-down list.

If you are creating an OCH trail circuit between CRS-1 routers, choose the destination CRS-1 router 
from the Node drop-down list. The Shelf, Slot, and Port fields are not available. CTC automatically 
selects the PLIM port depending on the OCHNC Wavelength value specified in Step 5.

The destination In and Out shelf (multishelf only), slot, and port appear under the OTS Lines area to 
show the destination in and out shelf, slots, and ports.

Step 10 Click Next.

Step 11 Complete the “DLP-G437 Set OCH Circuit Attributes” task on page 7-14.

Step 12 Click Next.

Step 13 Complete the “DLP-G438 Set OCH Routing Preferences” task on page 7-15. Skip this step and continue 
with Step 14 if no constraints are needed. If the trunk ports are already connected by an existing OCH 
Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in 
read-only mode; all buttons are disabled. Continue with Step 14.

Step 14 Click Finish. The Create Circuit wizard closes and the OCH trail circuit appears in the Circuits table 
with a DISCOVERED status in the Status column. (The circuit might take a few minutes to come up, 
depending on the size of the network.) 
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Step 15 Return to your originating procedure (NTP).

DLP-G418 Delete an Optical Channel Trail

Note If you are deleting more than half of all the active OCH trails, Cisco recommends that you delete them 
two at a time to allow for proper power compensation. You do not need to delete the active OCH trails 
two at a time if you are deleting all of them. 

Step 1 Complete the “NTP-G103 Back Up the Database” procedure on page 13-2 to preserve existing settings 
and, if you will recreate the circuits, record the circuit information.

Step 2 Consult your network operations center (NOC) or other appropriate personnel to verify that the OCH 
trail can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the OCH trail deletion. 

Step 4 From the View menu, choose Go to Network View. 

Step 5 Click the Circuits tab.

Step 6 Choose one or more OCH trails from the Type column that you want to delete, then click Delete.

Step 7 In the Delete Circuits confirmation dialog box, complete the following: 

• Change drop port admin state—Check this box if you want to change the administrative state for the 
circuit source and destination ports. After checking the box, choose one of the following 
administrative states: 

– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.

– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in 
service.

– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and 
disables them.

– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for 
maintenance.

• Notify when completed—If checked, the CTC Alerts confirmation dialog box indicates when the 
OCH trail is deleted. During this time, you cannot perform other CTC functions. If you are deleting 
many OCH trails, waiting for confirmation might take a few minutes. Circuits are deleted whether 
or not this check box is checked.

Purpose This task deletes DWDM OCH trail circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see 
the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on page 2-33. 
If the CTC Alerts dialog box is not set to open automatically with a notification, the red triangle 
inside the CTC Alerts toolbar icon indicates that a notification exists. 

Step 8 Complete one of the following:

• If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the 
information, continue with Step 9. If you do not want to save the information, continue with Step 10.

• If you did not check Notify when completed, the Circuits page appears. Continue with Step 11.

Step 9 If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you 
do not want to save it, continue with Step 11.

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a TXT file extension, and click OK.

Step 10 Click Close to close the CTC Alerts dialog box. 

Step 11 Complete the “NTP-G103 Back Up the Database” procedure on page 13-2 if you require a backup of 
your changes.

Step 12 Return to your originating procedure (NTP).

DLP-G425 Edit an OCH Trail Circuit Name

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab.

Step 3 Click the OCH trail whose name you want to edit, then click Edit. The Edit Circuit dialog box appears 
with the General tab displayed.

Step 4 In the Name field, enter the new OCH trail circuit name. 

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes the name of an OCH trail circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 7-23

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G419 Change an OCH Trail Administrative State

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Circuits tab.

Step 3 Click the OCH trail whose administrative state you want to change, then click Edit.

Step 4 In the Edit Circuit dialog box, click the State tab.

Step 5 Click the cell in the Admin State column for the card you want to change, and choose an administrative 
state from the drop-down list:

• IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

• OOS,DSBLD (ANSI) or Locked (ETSI)

Step 6 Click Apply.

Step 7 If you are changing the OCH trail state to OOS/Locked, click OK in the confirmation dialog. (No 
confirmation dialog appears when you place OCH trails in service.)

Note For information about the OCH circuit state transitions, refer to the “Administrative and Service States” 
appendix in the Cisco ONS 15454 DWDM Reference Manual.

Step 8 Return to your originating procedure (NTP).

NTP-G59 Create, Delete, and Manage Optical Channel Network 
Connections

Purpose This task changes the administrative state of an OCH trail circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G395 Create an Optical Channel Trail, page 7-17

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates and deletes DWDM OCHNC channels and changes 
their administrative states.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you want to 
manage OCHNCs. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G105 Provision Optical Channel Network Connections” task on page 7-23, as 
needed.

Step 3 Complete the “DLP-G493 Provision Protected Optical Channel Network Connections” task on 
page 7-25, as needed.

Step 4 Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-27, as needed.

Step 5 Complete the “DLP-G426 Edit an OCHNC Circuit Name” task on page 7-28, as needed.

Step 6 Complete the “DLP-G420 Change an OCHNC Administrative State” task on page 7-29, as needed.

Stop. You have completed this procedure.
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DLP-G105 Provision Optical Channel Network Connections

Note In a node using OTU2_XP cards configured in the regen mode, you must create two OCHNC circuits, 
one on either side of the card.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list. 

Step 4 Click Next.

Step 5 In the Circuit area of the Circuit Attributes page, provision the OCHNC circuit attributes (Figure 7-3 on 
page 7-24):

Purpose This task creates an OCHNC between two optical nodes upon a specified 
C-band or L-band wavelength through the ports residing on the following 
wavelength selective switches, multiplexers, demultiplexer, and add/drop 
cards:

• 32WSS

• 32WSS-L

• 40-WSS-C

• 40-WSS-CE

• 32DMX-O

• 32DMX

• 32DMX-L

• 40-DMX-C

• 40-DMX-CE

• 4MD

• AD-1B-xx.x

• AD-4B-xx.x

• AD-1C-xx.x

• AD-4C-xx.x

OCH trails, which carry OCHCC circuits, are associated to the OCHNCs.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

An OCHNC add port on the source node and an OCHNC drop port on 
destination node of the same wavelength

Cisco TransportPlanner Traffic Matrix Report

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Name—Assign a name to the OCHNC. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—(Display only) OCHNC.

• Size—(Display only) Equipped non specific is the default.

• OCHNC Wavelength—Choose a band (either C Band or L Band) and wavelength number type 
(Odd or Even) in the lower drop-down list. Then, choose the wavelength that you want to provision 
in the upper drop-down list. See Table 7-2 on page 7-7 for C-band and Table 7-3 on page 7-8 for 
L-band wavelengths.

• Bidirectional—Check this box to create a bidirectional OCHNC; uncheck it to create a 
unidirectional OCHNC.

• OCHNC DCN—Check this box to create an OCHNC DCN. The OCHNC DCN establishes 
preliminary connectivity between nodes that lack LAN or optical service channel (OSC) 
connections. After the OCHNC is created, you create a GCC termination to provide permanent 
communications channel between the nodes. See the “DLP-G76 Provision DCC/GCC 
Terminations” task on page 7-63.

• Protection—Check to create a protected OCHNC. For more details, see the “DLP-G493 Provision 
Protected Optical Channel Network Connections” task on page 7-25.

• State—Provisions the OCHNC circuit state. The state can be IS,AINS (ANSI)/Unlocked, 
automatic in-service (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI). 

Figure 7-3 OCHNC Attributes Page

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source 
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, 
and, if needed, the source port from the Port drop-down list.

The source In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 8 Click Next. 
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Step 9 In the Circuit Destination area, choose the destination node from the Node drop-down list, then choose 
the destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the 
Slot drop-down list, and, if needed, the destination port from the Port drop-down list.

The destination In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 10 Click Next. 

Step 11 Skip this step and continue with Step 12 if no constraints are needed. If the trunk ports are already 
connected by an existing OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing 
Preferences page appears in read-only mode; all buttons are disabled. Continue with Step 12. If not, 
complete the “DLP-G438 Set OCH Routing Preferences” task on page 7-15.

Step 12 Click Finish. The Circuit Creation wizard closes and the new OCHNC appears in the Circuits table with 
a DISCOVERED status in the Status column. (The circuit might take a few minutes to come up, 
depending on the size of the network.)

Step 13 Return to your originating procedure (NTP).

DLP-G493 Provision Protected Optical Channel Network Connections

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list. 

Step 4 Click Next.

Step 5 In the Circuit area of the Circuit Attributes page, provision the OCHNC circuit attributes (Figure 7-4 on 
page 7-26):

• Name—Assign a name to the OCHNC. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—(Display only) OCHNC.

• Size—(Display only) Equipped non specific is the default.

Purpose This task creates a protected OCHNC circuit when a PSM card is 
provisioned at the endpoint nodes of a DWDM network. OCH trails, which 
carry OCHCC circuits, are associated to the OCHNCs.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

An OCHNC add port on the source node and an OCHNC drop port on 
destination node of the same wavelength

Cisco TransportPlanner Traffic Matrix Report

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• OCHNC Wavelength—Choose a band (either C Band or L Band) and wavelength number type 
(Odd or Even) in the lower drop-down list. Then, choose the wavelength that you want to provision 
in the upper drop-down list. See Table 7-2 on page 7-7 and Table 7-3 on page 7-8 for C-band and 
L-band wavelengths.

• Bidirectional—Check this box to create a bidirectional OCHNC; uncheck it to create a 
unidirectional OCHNC. This field is not available if you check the Protection option.

• OCHNC DCN—Check this box to create an OCHNC DCN. The OCHNC DCN establishes 
preliminary connectivity between nodes that lack LAN or optical service channel (OSC) 
connections. After the OCHNC is created, you create a GCC termination to provide permanent 
communications channel between the nodes. See the “DLP-G76 Provision DCC/GCC 
Terminations” task on page 7-63.

• Protection—Check to create a protected OCHNC (only endpoint nodes equipped with PSM cards 
will be selectable as circuit endpoints).

• State—Provisions the OCHNC circuit state. The state can be IS,AINS (ANSI)/Unlocked, 
automatic in-service (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI). 

Figure 7-4 OCHNC Attributes Page

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the source node from the Node drop-down list. Only endpoint nodes 
equipped with PSM cards are available for selection in the Node drop-down list. The slot, port, and the 
source In and Out OTS lines are automatically chosen by CTC. 

Step 8 Click Next. 

Step 9 In the Circuit Destination area, choose the destination node from the Node drop-down list. Only endpoint 
nodes equipped with PSM cards are available for selection in the Node drop-down list. The slot, port, 
and the source In and Out OTS lines are automatically chosen by CTC.

Step 10 Click Next. CTC completes the circuit creation by routing two distinct paths (a working path and a 
protected path) from the source node to the destination node. The working path is the one exiting the 
In/Out working source OTS lines and entering the In/Out working destination OTS lines. The protected 
path is the one exiting the In/Out protected source OTS lines and entering the In/Out protected 
destination OTS lines.
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Step 11 Complete the “DLP-G438 Set OCH Routing Preferences” task on page 7-15. Skip this step and continue 
with Step 12 if no constraints are needed. If the trunk ports are already connected by an existing OCH 
Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in 
read-only mode; all buttons are disabled. Continue with Step 12.

Step 12 Click Finish. The Circuit Creation wizard closes and the new OCHNC appears in the Circuits table with 
a DISCOVERED status in the Status column. (The circuit might take a few minutes to appear, depending 
on the size of the network.)

Step 13 Return to your originating procedure (NTP).

DLP-G106 Delete Optical Channel Network Connections

Note If you are deleting more than half of all the active OCHNCs, Cisco recommends that you delete them 
two at a time to allow for proper power compensation. You do not need to delete the active OCHNCs two 
at a time if you are deleting all the them.

Step 1 To preserve existing settings you must back up the database of every node on the circuit's path. Complete 
the “NTP-G103 Back Up the Database” procedure on page 13-2 to back up the databases for all nodes 
on the circuit path. Record the circuit information if you plan to recreate the circuit.

Step 2 Consult your NOC or other appropriate personnel to verify that the OCHNC can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the OCHNC deletion. 

Step 4 From the View menu, choose Go to Network View. 

Step 5 Click the Circuits tab.

Step 6 In the Circuits table, use the Circuit Name and Type columns to select the OCHNCs that you want to 
delete. (To choose more than one OCHNC, press the Shift or Control keys as you click the circuits.)

Step 7 Click Delete.

Step 8 In the Delete Circuits confirmation dialog box, check Notify when completed, as needed. 

If checked, the CTC Alerts confirmation dialog box will alert you when the OCHNC is deleted. During 
this time, you cannot perform other CTC functions. If you are deleting many OCHNCs, waiting for 
confirmation might take a few minutes. Circuits are deleted whether or not this check box is checked.

Purpose This task deletes DWDM OCHNC circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see 
the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on page 2-33. 
If the CTC Alerts dialog box is not set to open automatically with a notification, the red triangle 
inside the CTC Alerts toolbar icon indicates that a notification exists. 

Step 9 Complete one of the following:

• If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the 
information, continue with Step 10. If you do not want to save the information, continue with 
Step 11.

• If you did not check Notify when completed, the Circuits page appears. Continue with Step 12.

Step 10 If you want to save the information in the CTC Alerts dialog box, complete the following steps. 

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a.txt file extension, and click OK.

Step 11 Click Close to close the CTC Alerts dialog box. 

Step 12 Complete the “NTP-G103 Back Up the Database” procedure on page 13-2 for every node on the circuit’s 
path if you require a backup of your changes.

Step 13 Return to your originating procedure (NTP).

DLP-G426 Edit an OCHNC Circuit Name

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab.

Step 3 Click the OCHNC whose name you want to edit, then click Edit. The Edit Circuit dialog box appears 
with the General tab displayed.

Step 4 In the Name field, enter the new OCHNC circuit name. 

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes the name of an OCHNC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 7-23

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G420 Change an OCHNC Administrative State

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab.

Step 3 Click the OCHNC with the administrative state you want to change, then click Edit.

Step 4 In the Edit Circuit dialog box, click the State tab.

Step 5 Choose an administrative state from the drop-down list:

• IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

• OOS (ANSI) or Locked (ETSI)

Step 6 Click Apply.

Step 7 If you are changing the OCHNC state to OOS,DSBLD (ANSI) or Locked,Disabled (ETSI), click OK in 
the confirmation dialog. (No confirmation dialog appears when you place OCH trails in service.)

Note For information about the OCH circuit state transitions, refer to the “Administrative and Service States” 
appendix in the Cisco ONS 15454 DWDM Reference Manual.

Step 8 Return to your originating procedure (NTP).

NTP-G200 Create, Delete, and Manage STS or VC Circuits for the 
ADM-10G Card

Purpose This task changes the administrative state of an OCHNC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 7-23

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates and deletes STS and VC circuits for the ADM-10G 
card.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you want to 
manage the STS or VC circuits. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the STS or VC source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 7-3. If not, continue with the next step.

Step 3 If you are creating STS or VC circuits on ADM-10G cards across two nodes, you must complete the 
“DLP-G395 Create an Optical Channel Trail” task on page 7-17. If not, continue with the next step.

Step 4 Complete the “DLP-G463 Create an Automatically Routed STS or VC Circuit” task on page 7-30, as 
needed.

Step 5 Complete the “DLP-G464 Create a Manually Routed STS or VC Circuit” task on page 7-34, as needed.

Step 6 Complete the “DLP-G467 Edit an STS or VC Circuit Name” task on page 7-39, as needed.

Step 7 Complete the “DLP-G466 Delete an STS or VC Circuit” task on page 7-38, as needed.

Stop. You have completed this procedure.

DLP-G463 Create an Automatically Routed STS or VC Circuit

Note This procedure requires the use of automatic routing. Automatic routing is not available if both the 
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE 
default are set to FALSE. For a full description of these defaults see the “Network Element Defaults” 
appendix in the Cisco ONS 15454 Reference Manual.

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS for a SONET circuit from the Circuit Type list.

For an SDH circuit the choices are, VC_HO_PATH_CIRCUIT, VC_LO_PATH_CIRCUIT, 
VC_LO_PATH_TUNNEL, VC_LO_PATH_AGGREGATION, 
VC_HO_PATH_VCAT_CIRCUIT, or VC_LO_PATH_VCAT_CIRCUIT.

• Number of Circuits—Enter the number of STS or VC circuits that you want to create. The default 
is 1. If you are creating multiple circuits with the same slot and sequential port numbers, you can 
use Auto-ranged to create the circuits automatically. 

Purpose This procedure creates an automatically routed STS or VC circuit for the 
ADM-10G card. CTC chooses the circuit route based on the parameters 
you specify and on the software version.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of 
Circuits field. Auto-ranging creates identical (same source and destination) sequential circuits 
automatically. Uncheck the box if you do not want CTC to create sequential circuits automatically.

Step 4 Click Next.

Step 5 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters, 
(including spaces). Circuit names should be 43 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size. 

– Available SONET circuits are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-18c, STS-24c , 
STS-36c, STS-48c, and STS-192c.

– Available SDH circuits are VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, VC4-8c, VC4-12c, 
VC4-16c, and VC4-64c.

Note For creating a circuit using a Gigabit Ethernet port, choose the circuit size as STS-24c for a 
SONET circuit or VC4-8c for a SDH circuit.

Note An equivalent SDH circuit size for STS-1 SONET circuit does not exist.

• Bidirectional—Leave checked for this circuit (default).

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits.

• Diagnostic—Leave unchecked.

• State—Choose the administrative state to apply to all of the cross-connects in a circuit:

– IS (ANSI)/Unlocked (ETSI)—Puts the circuit cross-connects in the IS-NR (ANSI) or 
unlocked-enabled (ETSI) service state.

– OOS,DSBLD (ANSI)/Locked,Disabled (ETSI)—Puts the circuit cross-connects in the 
OOS-MA,DSBLD (ANSI) or locked-enabled,disabled (ETSI) service state. Traffic is not passed 
on the circuit.

– IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI)—Puts the circuit cross-connects in the 
OOS-AU,AINS (ANSI) or unlocked-disabled,automaticInService (ETSI) service state and 
suppresses alarms and conditions. When the connections receive a valid signal, the service state 
automatically changes to IS-NR (ANSI) or unlocked-enabled (ETSI).

– OOS,MT (ANSI)/Locked,maintenance (ETSI)—Puts the circuit cross-connects in the 
OOS-MA,MT (ANSI) or locked-enabled,maintenance (ETSI) service state. The maintenance 
state does not interrupt traffic flow; it suppresses alarms and conditions and allows loopbacks 
to be performed on the circuit. Use OOS,MT (ANSI) or locked,maintenance (ETSI) for circuit 
testing or to suppress circuit alarms temporarily.

• Apply to drop ports—Check this check box if you want to apply the administrative state chosen in 
the State field to the circuit source and destination ports. CTC applies the administrative state to the 
ports only if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is 
larger than the circuit, the circuit must be the first circuit to use the port. If not, a Warning dialog 
box displays the ports where the administrative state could not be applied. If the check box is 
unchecked, CTC does not apply the administrative state to the source and destination ports.
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Note If ports managed into the IS (ANSI) or Unlocked (ETSI) administrative state are not 
receiving signals, loss of signal alarms are generated and the port service state transitions to 
OOS-AU,FLT (ANSI) or Unlocked-disabled,failed (ETSI).

• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, 1+1, or optimized 1+1 protection. If you check this box, CTC 
displays only protected cards and ports as source and destination choices.

Step 6 If the circuit will be routed on a path protection configuration, complete the “DLP-G465 Provision Path 
Protection Selectors” task on page 7-37. Otherwise, continue with Step 7.

Step 7 Click Next. 

Step 8 In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source 
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, 
and, if needed, the source port from the Port drop-down list. For most cards, the port will be 
automatically chosen.

Step 9 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection configuration, click Use Secondary Source and repeat Step 8 to 
define the secondary source. If you do not need to create a secondary source, continue with Step 10.

Step 10 Click Next. 

Step 11 In the Circuit Destination area, choose the destination node from the Node drop-down list (only the 
source node will be available because the source and destination nodes are the same), then choose the 
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot 
drop-down list, and, if needed, the destination port from Port drop-down list.

Step 12 Click Next.

Step 13 In the Circuit Routing Preferences area, choose Route Automatically. Two options are available; choose 
either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box if you want to specify nodes and spans to 
include or exclude in the CTC-generated circuit route. 

Including nodes and spans for a circuit ensures that those nodes and spans are in the working path 
of the circuit (but not the protect path). Excluding nodes and spans ensures that the nodes and spans 
are not in the working or protect path of the circuit.

• Review Route Before Creation—Check this check box if you want to review and edit the circuit 
route before the circuit is created. 

Step 14 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 15. CTC creates a fully protected circuit route based on the path diversity option you choose. 
Fully protected paths might or might not have path protection path segments (with primary and 
alternate paths), and the path diversity options apply only to path protection path segments, if any 
exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 16.

Step 15 If you selected Fully Protected Path in Step 14 and the circuit will be routed on a path protection 
configuration, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
portions of the complete circuit path are nodally diverse. 
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• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 16 If you checked Using Required Nodes/Spans in Step 13, complete the following substeps. Otherwise, 
continue with Step 17.

a. In the Circuit Constraints for Automatic Routing area, click a node or span on the circuit map.

b. Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit is routed. Click spans twice to change the circuit direction. 

c. Repeat Step b for each node or span you wish to include or exclude.

d. Review the circuit route. To change the circuit routing order, choose a node in the Required 
Nodes/Lines or Excluded Nodes Links lists and click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 17 Click Next.

Step 18 If you selected Review Route Before Creation in Step 13, complete the following substeps. If not, 
continue with Step 19. 

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“DLP-G464 Create a Manually Routed STS or VC Circuit” procedure on page 7-34.

Step 19 Click Finish. One of the following results occurs if you entered more than one circuit in the Number of 
Circuits field on the Circuit Creation dialog box. 

• If you chose Auto-ranged, CTC automatically creates the number of circuits entered in the Number 
of Circuits field. If auto-ranging cannot complete all the circuits, for example, because sequential 
ports are unavailable at the source or destination, a dialog box appears. Set the new source or 
destination for the remaining circuits, then click Finish to continue auto-ranging. After completing 
the circuits, the Circuits window appears.

• If you did not choose Auto-ranged, the Circuit Creation dialog box appears so you can create the 
remaining circuits. Repeat Steps 3 through 18 for each additional circuit. After completing the 
circuits, the Circuits window appears.

Step 20 In the Circuits window, verify that the new circuits appear in the circuits list.

Stop. You have completed this procedure.
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DLP-G464 Create a Manually Routed STS or VC Circuit

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS for a SONET circuit from the Circuit Type list.

For an SDH circuit the choices are, VC_HO_PATH_CIRCUIT, VC_LO_PATH_CIRCUIT, 
VC_LO_PATH_TUNNEL, VC_LO_PATH_AGGREGATION, 
VC_HO_PATH_VCAT_CIRCUIT, or VC_LO_PATH_VCAT_CIRCUIT.

• Number of Circuits—Enter the number of STS or VC circuits that you want to create. The default 
is 1. 

• Auto-ranged—(Automatically routed circuits only) If you entered more than 1 in the Number of 
Circuits field on the Circuit Creation dialog box, uncheck this box. (The box is unavailable if only 
one circuit is entered in the Number of Circuits field.)

Step 4 Click Next.

Step 5 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 43 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size. 

– Available SONET circuits are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-18c, STS-24c , 
STS-36c, STS-48c, and STS-192c.

– Available SDH circuits are VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, VC4-8c, VC4-12c, 
VC4-16c, and VC4-64c.

Note For creating a circuit using a Gigabit Ethernet port, choose the circuit size as STS-24c for a 
SONET circuit or VC4-8c for a SDH circuit.

• Bidirectional—Leave checked for this circuit (default).

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits.

• State—Choose the administrative state to apply to all of the cross-connects in a circuit:

– IS (ANSI)/Unlocked (ETSI)—Puts the circuit cross-connects in the IS-NR (ANSI) or 
unlocked-enabled (ETSI) service state.

Purpose This procedure creates an STS or VC circuit and allows you to provision 
the circuit route for the ADM-10G card. 

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS,DSBLD (ANSI)/Locked,Disabled (ETSI)—Puts the circuit cross-connects in the 
OOS-MA,DSBLD (ANSI) or locked-enabled,disabled (ETSI) service state. Traffic is not passed 
on the circuit.

– IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI)—Puts the circuit cross-connects in the 
OOS-AU,AINS (ANSI) or unlocked-disabled,automaticInService (ETSI) service state and 
suppresses alarms and conditions. When the connections receive a valid signal, the service state 
automatically changes to IS-NR (ANSI) or unlocked-enabled (ETSI).

– OOS,MT (ANSI)/Locked,maintenance (ETSI)—Puts the circuit cross-connects in the 
OOS-MA,MT (ANSI) or locked-enabled,maintenance (ETSI) service state. The maintenance 
state does not interrupt traffic flow; it suppresses alarms and conditions and allows loopbacks 
to be performed on the circuit. Use OOS,MT (ANSI) or locked,maintenance (ETSI) for circuit 
testing or to suppress circuit alarms temporarily.

• Apply to drop ports—Check this check box if you want to apply the administrative state chosen in 
the State field to the circuit source and destination ports. CTC applies the administrative state to the 
ports only if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is 
larger than the circuit, the circuit must be the first circuit to use the port. If not, a Warning dialog 
box displays the ports where the administrative state could not be applied. If the check box is 
unchecked, CTC does not apply the administrative state to the source and destination ports.

Note If ports managed into the IS (ANSI) or Unlocked (ETSI) administrative state are not 
receiving signals, loss of signal alarms are generated and the port service state transitions to 
OOS-AU,FLT (ANSI) or Unlocked-disabled,failed (ETSI).

• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, 1+1, or optimized 1+1 protection. If you check this box, CTC 
shows only protected cards and ports as source and destination choices.

Step 6 If the circuit will be routed on a path protection configuration, complete the “DLP-G465 Provision Path 
Protection Selectors” task on page 7-37. Otherwise, continue with Step 7.

Step 7 Click Next. 

Step 8 In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source 
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, 
and, if needed, the source port from the Port drop-down list. For most cards, the port will be 
automatically chosen.

Step 9 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection configuration, click Use Secondary Source and repeat Step 8 to 
define the secondary source. If you do not need to create a secondary source, continue with Step 10.

Step 10 Click Next. 

Step 11 In the Circuit Destination area, choose the destination node from the Node drop-down list (only the 
source node will be available because the source and destination nodes are the same), then choose the 
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot 
drop-down list, and, if needed, the destination port from Port drop-down list.

Step 12 Click Next.

Step 13 In the Circuit Routing Preferences area, uncheck Route Automatically. 

Step 14 To set the circuit path protection, complete one of the following:
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• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 15. Fully protected paths might or might not have path protection path segments (with primary 
and alternate paths), and the path diversity options apply only to path protection path segments, if 
any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 17.

Step 15 If you selected Fully Protected Path in Step 14 and the circuit will be routed on a path protection 
configuration, choose a Node-Diverse Path option: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 16 Click Next.

Step 17 In the Route Review/Edit area, node icons appear for you to route the circuit manually. Click the source 
node icon if it is not already selected.

Step 18 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns yellow. In the Selected Span area, the From and To fields provide span information. The 
source STS or VC appears.

Step 19 If you want to change the source STS or VC, adjust the Source STS or VC field; otherwise, continue 
with Step 20. 

Step 20 Click Add Span. The span is added to the Included Spans list and the span arrow turns blue.

Step 21 If the Fully Protect Path check box is checked in the Circuit Routing Preferences panel, you must add 
two spans for all path protection or unprotected portions of the circuit route from the source to the 
destination.

Step 22 Repeat Steps 18 through 21 until the circuit is provisioned from the source to the destination node 
through all intermediary nodes.

Step 23 Click Finish. CTC compares your manually provisioned circuit route with the specified path diversity 
option you chose in Step 15. If the path does not meet the specified path diversity requirement, CTC 
displays an error message and allows you to change the circuit path. 

Step 24 If you entered more than 1 in the Number of Circuits field on the Circuit Creation dialog box, the Circuit 
Creation dialog box appears so you can create the remaining circuits. Repeat Steps 3 through 23 for each 
additional circuit.

Step 25 When all the circuits are created, the main Circuits window appears. Verify that the circuits you created 
are correct.

Stop. You have completed this procedure.
7-36
Cisco ONS 15454 DWDM Procedure Guide, R9.0

78-18376-02



 

Chapter 7      Create Circuits and Provisionable Patchcords
DLP- G465 Provision Path Protection Selectors
DLP-G465 Provision Path Protection Selectors

Note Provisioning path signal degrade (SD-P) or path signal fail (SF-P) thresholds in the Circuit Attributes 
page of the Circuit Creation wizard sets the values only for path protection-protected spans. The circuit 
source and destination use the node default values of 10E-4 for SD-P and 10E-6 for SF-P for unprotected 
circuits and for the source and drop of path protection circuits.

Step 1 In the path protection area of the Circuit Attributes page of the Circuit Creation wizard, set the path 
protection selectors:

• Provision working go and return on primary path—Check this box to route the working path on one 
fiber pair and the protect path on a separate fiber pair. This feature only applies to bidirectional path 
protection circuits. 

• Revertive—Check this box if you want traffic to revert to the working path when the conditions that 
diverted it to the protect path are repaired. If you do not choose Revertive, traffic remains on the 
protect path after the switch.

• Reversion time—If Revertive is checked, click the Reversion time field and choose a reversion time 
from the drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the 
amount of time that will elapse before the traffic reverts to the working path. Traffic can revert when 
conditions causing the switch are cleared.

• SF threshold—Set the path protection path-level signal failure bit error rate (BER) thresholds. 

• SD threshold—Set the path protection path-level signal degrade BER thresholds.

• Switch on PDI-P—Check this box if you want traffic to switch when an STS or VC payload defect 
indicator is received.

Step 2 Return to your originating procedure (NTP).

Purpose This task provisions path protection selectors during circuit creation or 
during a topology upgrade conversion. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

The Circuit Attributes page of the Circuit Creation wizard must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G466 Delete an STS or VC Circuit

Step 1 Complete the “NTP-G103 Back Up the Database” procedure on page 13-2 to preserve existing settings 
and, if you will recreate the circuits, record the circuit information.

Step 2 Verify that traffic is no longer carried on the circuit and that the circuit can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the circuit deletion. 

Step 4 From the View menu, choose Go to Network View. 

Step 5 Click the Circuits tab.

Step 6 Choose one or more STS or VC circuits from the Type column that you want to delete, then click Delete.

Step 7 In the Delete Circuits confirmation dialog box, complete the following: 

• Change drop port admin state—Check this box if you want to change the administrative state for the 
circuit source and destination ports. After checking the box, choose one of the following 
administrative states: 

– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.

– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in 
service.

– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and 
disables them.

– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for 
maintenance.

• Notify when completed—If checked, the CTC Alerts confirmation dialog box indicates when the 
circuit is deleted. During this time, you cannot perform other CTC functions. If you are deleting 
many circuits, waiting for confirmation might take a few minutes. Circuits are deleted whether or 
not this check box is checked.

Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see 
the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on page 2-33. 
If the CTC Alerts dialog box is not set to open automatically with a notification, the red triangle 
inside the CTC Alerts toolbar icon indicates that a notification exists. 

Step 8 Complete one of the following:

• If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the 
information, continue with Step 9. If you do not want to save the information, continue with Step 10.

• If you did not check Notify when completed, the Circuits page appears. Continue with Step 11.

Purpose This task deletes STS or VC circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you 
do not want to save it, continue with Step 11.

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a TXT file extension, and click OK.

Step 10 Click Close to close the CTC Alerts dialog box. 

Step 11 Complete the “NTP-G103 Back Up the Database” procedure on page 13-2 if you require a backup of 
your changes.

Step 12 Return to your originating procedure (NTP).

DLP-G467 Edit an STS or VC Circuit Name

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab.

Step 3 Click the STS or VC circuit whose name you want to edit, then click Edit. The Edit Circuit dialog box 
appears with the General tab displayed.

Step 4 In the Name field, enter the new STS or VC circuit name. 

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes the name of an STS or VC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G150 Upgrade Optical Channel Network Connections to 
Optical Channel Client Connections

Note During this procedure, the OCHNC is replaced with two circuit types, the OCHCC, which establishes a 
connection between the client card client ports, and the OCH trail, which establishes a connection 
between the client card trunk ports. The OCH trail is given the same name as the OCHNC. The OCHCC 
is given a system-generated name in the format: circuit-type_NE-name::unique sequence number. To 
edit the OCHCC circuit name, complete the “DLP-G424 Edit an OCHCC Circuit Name” task on 
page 7-13. To edit the OCH trail circuit name, complete the “DLP-G424 Edit an OCHCC Circuit Name” 
task on page 7-13.

Note Multiple OCHCCs might use the same OCH trail. The OCH Wlen (wavelength) parameter on the 
Circuits page can be used to determine the OCHCC and OCH trail associations.

Step 1 As needed, identify the OCHCC to be provisioned using the “DLP-G350 Use the Cisco TransportPlanner 
Traffic Matrix Report” task on page 6-26.

Step 2 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you want to 
upgrade the OCHNCs. If you are already logged in, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab and find the OCH you want to upgrade.

Step 5 Record the following information:

• OCHNC Wlen (OCHNC wavelength)

• Source node/shelf (if applicable)/slot/port/side (include both Side A and Side B nodes, if present)

• Destination node/shelf (if applicable)/slot/port/side (include both Side A and Side B nodes, if 
present)

Step 6 Use the information recorded in Step 5 to complete one of the following 

• DLP-G344 Verify Provisionable and Internal Patchcords, page 7-43—Complete this task if 
provisionable patchcords (PPCs) and internal patchcords exist on the network but you are not sure 
whether one was created for the OCHNC that you want to upgrade.

Purpose This procedure upgrades OCHNCs created in earlier software releases to 
OCHCCs. It also upgrades an OCHNC circuit to an OCH trail circuit 
(without the OCHCC circuit) in case the PPCs or internal patchcords 
connect to an ADM_10G or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
(only in L2 over DWDM mode) cards.

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 7-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• NTP-G184 Create a Provisionable Patchcord, page 7-54—Complete this procedure if you know that 
PPCs were not created between the OCHNC node and the client node. If you recently upgraded from 
a previous release, you must create PPCs between the source client and OCHNC node and between 
the destination client and OCHNC node.

Step 7 In network view, click the OCHNC that you want to upgrade. 

Step 8 From the Tools menu, choose Circuits > Upgrade OCHNC. If the Upgrade OCHNC Initialization 
“Completed” status appears (Figure 7-5), continue with Step 9. If the “Failed” status appears 
(Figure 7-6), complete the following substeps:

a. Click each failure reason to view the failure details. A common cause of initialization failures is the 
absence or incorrect completion of PPCs or internal patchcords between the client nodes and the 
optical channel (OCH) nodes. 

b. Repeat Steps 3 through 8, verifying that the OCHNC ports and provisionable patchcord (PPC) path 
match on both sides. If the upgrade “Failed” status appears again, click Save to save the results to a 
local or network computer. (The file can be opened with any text editor.) Then, contact your next 
level of support.

Figure 7-5 Upgrade OCHNC Initialization—Completed
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Figure 7-6 Upgrade OCHNC Initialization—Failed

Step 9 Click each result to review the details. If you want to save the results, click Save and save the results to 
a file on a local or network computer. Click Continue.

Step 10 Review the information in the Upgrade OCHNC dialog box (Figure 7-7), then click OK.

Step 11 Click Yes in the confirmation dialog box, then click OK on the Completed Upgrade OCHNC wizard 
page.

Tip To see all of the information in the Source and Destination table cells, increase the column 
widths by clicking and dragging the column heading borders to the right or left.

Figure 7-7 Upgrade OCHNC Dialog Box
15
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Click to display details
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Step 12 View the OCHCC and its OCH trail in the Circuits page. For information and procedures for viewing 
and editing OCHCC and OCH trails, see the “NTP-G58 Locate and View Optical Channel Circuits” 
procedure on page 7-47.

Stop. You have completed this procedure.

DLP-G344 Verify Provisionable and Internal Patchcords

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Provisionable Patchcords (PPC) tabs.

Step 3 Use one of the following methods to verify that PPCs exist from the client TXP, MXP, ADM-10G, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, or ITU-T line card node, slot, and port to the 
DWDM OCH node, slot, port, and wavelength:

• Review the Patchcord Terminations table. PPCs should exist from the client TXP, MXP, ADM-10G, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, or ITU-T line card node to the OCH node, 
slot, and port recorded in the referring procedure. 

• Review the network graphic (see Figure 7-8). PPCs are represented by a small hand holding a 
lambda symbol. Clicking the PPC line on the graphic displays the PPC source and destination nodes, 
slots, and ports in the CTC information area. This information should match the node, slot, and port 
recorded in the referring procedure.

Purpose This task verifies the PPCs that are required between client TXP, MXP, 
ADM-10G, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, or 
ITU-T line cards and OCH DWDM nodes for OCHCCs. This task is not 
required for OCHNCs.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 7-8 Viewing the Provisionable Patchcords Table

Step 4 Display the OCHCC source node in node view. 

Step 5 Click the Provisioning > WDM-ANS > Internal Patchcords tab. 

Step 6 Verify that internal patchcords exist from the source TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, or OTU2_XP OCH trunk port to the OCH filter port. If so, continue with Step 7. If not, 
complete the“DLP-G354 Create an Internal Patchcord Manually” task on page 3-100.

Step 7 Display the OCHCC destination node in node view. 

Step 8 Click the Provisioning > WDM-ANS > Internal Patchcords tab. 

Step 9 Verify that internal patchcords exist from the destination TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, or OTU2_XP trunk port to the OCH filter port. If so, you are completed with this task. If 
not, complete the “DLP-G354 Create an Internal Patchcord Manually” task on page 3-100.

Step 10 Return to your originating procedure (NTP).

PPC lines
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NTP-G183 Diagnose and Fix OCHNC and OCH Trail Circuits

Note This procedure cannot be used for OCHCC circuits.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you want to 
diagnose and fix the OCHNC or OCH trail circuit. If you are already logged in, continue with Step 2.

Note Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this 
option is checked.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Circuits tab.

Step 4 Click the OCHNC or OCH trail that you want to diagnose.

Step 5 Click Edit.

Step 6 In the Edit Circuit dialog box, click the Diagnostic and Fix tab.

Step 7 Click Start. The diagnostic checks all OCHNC or OCH trail node connections and displays the results 
in an expandable tree view under the OCH diagnostic heading.

Step 8 Double-click OCH diagnostic to display the diagnostic messages.

• No problems are found—A “node: No issues found” message appears, where node is the node name 
or IP address of an ONS 15454 containing the OCHNC or OCH trail source, destination, or 
pass-through connection. If this message appears for all nodes, continue with Step 9.

• Problems are found—Double click on the nodes with problems and the error messages appear with 
a hyperlink labeled Fix or Check. If error messages appear, complete the fixes using the tasks and 
procedures listed in Table 7-4.

Note Only one error per node is displayed. If multiple errors exist, you must fix the first error, 
then rerun the diagnostic to display the next error(s).

Purpose This procedure checks nodes that are traversed by an OCHNC or OCH trail 
circuit to verify that all conditions required for bringing the circuit in 
service are in place. If not, the procedure identifies the invalid condition 
and provides links to the location in CTC where it can be fixed.

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 7-23, or

DLP-G395 Create an Optical Channel Trail, page 7-17

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 If you want to save the diagnostic results to a text file, complete the following steps. If not, continue with 
Step 10. 

a. Click Save. 

b. In the Save Diagnostic and Fix to File dialog box, enter the local directory and file name, or click 
Browse to navigate to a directory where you want to save the file. 

c. Click OK. 

Step 10 Repeat Steps 7 through 9 until “No issues found” appears for all nodes traversed by the OCHNC or 
OCH trail circuit.

Stop. You have completed this procedure.

Table 7-4 Diagnostic and Fix Errors

Error Message Description/Fix

Invalid connection state 
for “circuit name”: 
administrative state

The circuit state is not valid. Click Fix to display the State tab of the 
Edit Circuit dialog box where you can change the circuit state using the 
“DLP-G419 Change an OCH Trail Administrative State” task on 
page 7-21 or the “DLP-G420 Change an OCHNC Administrative State” 
task on page 7-29.

Invalid admin state: 
administrative state

The state of a port traversed by the circuit is not valid, for example, the port 
is in service. Click Fix to display the card view Provisioning tab, where 
you can change the port administrative state using the appropriate task for 
changing the optical line settings in Chapter 11, “Change DWDM Card 
Settings.”

ANS couldn’t regulate the 
port

ANS could not be regulated for the port. Click Fix to display the node view 
Provisioning > WDM-ANS > Port Status tab where you can launch ANS 
using the “NTP-G37 Run Automatic Node Setup” procedure on 
page 3-109.

APC couldn’t regulate the 
port

APC could not be regulated for the port. Click Fix to display the network 
view Maintenance > APC tab. Double-click the domain to expand the 
view. Right-click the node/side and choose the end you want to view. APC 
information is displayed on the right side. Read any message that might 
explain the failure, or restart APC by completing the “DLP-G158 Enable 
Automatic Power Control” task on page 10-5.

APC regulation is running Indicates that APC regulation is running and must be allowed to finish. 
Click Check to display the node view Maintenance > DWDM > APC tab 
where you can monitor the APC regulation.

APC is not enabled for 
this side.

APC is not enabled on an ONS 15454 side. Click Fix to display the 
network view Maintenance > APC tab where you can enable APC using 
the “DLP-G158 Enable Automatic Power Control” task on page 10-5.
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NTP-G58 Locate and View Optical Channel Circuits

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you want to 
view the circuits. If you are already logged in, continue with Step 2.

Note Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this 
option is checked.

Step 2 As needed, complete the “DLP-G100 Search for Optical Channel Circuits” task on page 7-47.

Step 3 As needed, complete the “DLP-G101 View Optical Channel Circuit Information” task on page 7-48.

Step 4 As needed, complete the “DLP-G102 Filter the Display of Optical Channel Circuits” task on page 7-51.

Step 5 As needed, complete the “DLP-G103 View Optical Channel Circuits on a Span” task on page 7-53.

Step 6 As needed, complete the “DLP-G114 Export CTC Data” task on page 9-4.

Stop. You have completed this procedure.

DLP-G100 Search for Optical Channel Circuits

Step 1 Navigate to the appropriate CTC view:

• To search the entire network, from the View menu choose Go to Network View.

• To search for circuits that originate, terminate, or pass through a specific node, from the View menu 
choose Go to Other Node, then choose the node you want to search and click OK.

Purpose This procedure allows you to locate and view OCHNC, OCHCC and OCH 
trail circuits. You can also export circuit data into a text file.

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 7-23

DLP-G346 Provision Optical Channel Client Connections, page 7-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task searches for OCHNC, OCHCC, OCH trail, and ONS 15454 
circuits at the network, node, or card level. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• To search for circuits that originate, terminate, or pass through a specific card, double-click the card 
on the shelf graphic in node view (single-shelf mode) or shelf view (multishelf mode) to open the 
card in card view. 

Step 2 Click the Circuits tab.

Step 3 If you are in node or card view, choose the scope for the search, Node or Network (All), in the Scope 
drop-down list located at the bottom right side of the screen. Choose Node to see all of the circuits on 
that node, or choose Network (All) to see all circuits in the network.

Step 4 Click Search if you need to search through the list of circuits.

Step 5 In the Circuit Name Search dialog box, complete the following:

• Find What—Enter the text of the circuit name you want to find. This field is not case-sensitive.

• Match whole word only—Check this check box to instruct CTC to select circuits only if the entire 
word matches the text in the Find What field. 

• Match case—Check this check box to instruct CTC to select circuits only when the capitalization 
matches the capitalization entered in the Find What field.

• Direction—Choose the direction for the search. Searches are conducted up or down from the 
currently selected circuit.

Step 6 Click Find Next. If a match is found the circuit will be highlighted in the Circuits page. To continue the 
search, click Find Next again to find the next circuit.

Step 7 Repeat Steps 5 and 6 until you are finished, then click Cancel.

Step 8 Return to your originating procedure (NTP).

DLP-G101 View Optical Channel Circuit Information

Step 1 Navigate to the appropriate CTC view:

• To view circuits for an entire network, from the View menu choose Go to Network View.

• To view circuits that originate, terminate, or pass through a specific node, from the View menu 
choose Go to Other Node, then choose the node you want to search and click OK.

• To view circuits that originate, terminate, or pass through a specific card, in node view (single-shelf 
mode) or shelf view (multishelf mode), double-click the card containing the circuits you want to 
view.

Purpose This task provides information about OCHNC, OCHCC, OCH trail, and 
ONS 15454 circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note In node or card view, you can change the scope of the circuits that appear by choosing Card 
(in card view), Node, or Network from the Scope drop-down list in the bottom right corner 
of the Circuits page.

Step 2 Click the Circuits tab. The Circuits tab shows the following information:

Note The following order is the default column sequence, the order might be different on your screen, 
depending on your individual CTC setup. 

• Circuit Name—Name of the circuit. The circuit name can be manually assigned or automatically 
generated.

• Type—OCHNC, OCHCC, or OCH-Trail. 

Note The following circuit types are not applicable to DWDM nodes: STS, VT, VTT (VT tunnel), 
VAP (VT aggregation point), STS-v (STS VCAT circuit), VT-v (VT VCAT circuit), HOP 
(high-order circuit), LOP (low-order circuit), VCT (VC low-order tunnel), and VCA 
(low-order VCAT circuit).

• Size—Circuit size. OCHNC, OCHCC, and OCH-Trail sizes are Equipped not specific, Multi-rate, 
2.5 Gbps No FEC, 2.5 Gbps FEC, 10 Gbps No FEC, and 10 Gbps FEC.

Note The following circuit types under the circuit size column are not applicable to DWDM 
nodes: STS, VT, VCAT, VC12, VC11, VC3, and VC4. 

• OCHNC Wlen—The wavelength provisioned for the OCHNC, OCHCC, or OCH trail. See Table 7-2 
on page 7-7 for a list of channels and wavelengths.

• Dir—The circuit direction, either two-way or one-way.

• Protection—The type of circuit protection. See Table 7-5 on page 7-50 for a list of protection types.

• Status—The circuit status. See Table 7-6 on page 7-50 for a list of circuit statuses.

• Source—The circuit source in the format: node/slot/port “port name”. The port name will appear 
in quotes only if a name was assigned to it. (To assign names to ports, see the “DLP-G104 Assign a 
Name to a Port” task on page 7-3.)

• Destination—The circuit destination in the format: node/slot/port “port name”. The port name will 
appear in quotes only if a name was assigned to it. (To assign names to ports, see the “DLP-G104 
Assign a Name to a Port” task on page 7-3.)

• # of VLANS—The number of VLANs used by an Ethernet circuit. VLANs are not applicable to 
DWDM nodes.

• # of Spans—The number of internode links that constitute the circuit. Right-clicking the column 
title shows a shortcut menu from which you can choose Span Details to show or hide circuit span 
detail. 
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• State—The circuit service state, which is an aggregate of the service states of its cross-connects. For 
ANSI shelves, the service state is IS, OOS, or OOS-PARTIAL. For ETSI shelves, the service state 
is Unlocked, Locked, or Locked-partial. For more information about ANSI and ETSI service states, 
see the “Administrative and Service States” appendix in the Cisco ONS 15454 DWDM Reference 
Manual.

– IS/Unlocked—All cross-connects are in service and operational.

– OOS/Locked—For ANSI, all cross-connects are OOS-MA,MT and/or OOS-MA,DSBLD. For 
ETSI, all cross-connects are Locked-enabled,maintenance and/or Locked-enabled,disabled.

– OOS-PARTIAL/Locked-partial—At least one cross-connect is IS-NR (ANSI) or 
Unlocked-enabled (ETSI) and others are out-of-service.

Note Right-clicking a column title (Circuit name, Type, etc.) opens a shortcut menu that allows 
you to show or hide circuit details.

Table 7-5 Circuit Protection Types

Protection Type Description

Y-cable (OCHNC and OCH-Trail circuit types only) The circuit is protected by a 
transponder or muxponder card Y-cable protection group.

Splitter The circuit is protected by the protect transponder splitter protection.

Unprot A circuit with a source and destination on different nodes is not protected. 

N/A A circuit with connections on the same node is not protected. 

Unknown A circuit has a source and destination on different nodes and communication 
is down between the nodes. This protection type appears if not all circuit 
components are known.

Table 7-6 Cisco ONS 15454 Circuit Status

Status Definition/Activity

CREATING CTC is creating a circuit.

DISCOVERED CTC created a circuit. All components are in place and a complete path exists 
from the circuit source to the circuit destination.

DELETING CTC is deleting a circuit.
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Step 3 Return to your originating procedure (NTP).

DLP-G102 Filter the Display of Optical Channel Circuits

PARTIAL A CTC-created circuit is missing a cross-connect or network span, a complete 
path from source to destination(s) does not exist, or an alarm interface panel 
(AIP) change occurred on one of the circuit nodes and the circuit is in need 
of repair. (AIPs store the node MAC address.)

In CTC, circuits are represented using cross-connects and network spans. If a 
network span is missing from a circuit, the circuit status is PARTIAL. 
However, a PARTIAL status does not necessarily mean that a circuit traffic 
failure has occurred, because traffic might flow on a protect path. 

Network spans are in one of two states: up or down. On CTC circuit and 
network maps, up spans are shown as green lines, and down spans are shown 
as gray lines. If a failure occurs on a network span during a CTC session, the 
span remains on the network map but its color changes to gray to indicate the 
span is down. If you restart your CTC session while the failure is active, the 
new CTC session cannot discover the span and its span line will not appear 
on the network map. 

Subsequently, circuits routed on a network span that goes down will appear 
as DISCOVERED during the current CTC session, but they will appear as 
PARTIAL to users who log in after the span failure. 

This status does not appear for OCHNC circuit types.

DISCOVERED_TL1 A TL1-created circuit or a TL1-like CTC-created circuit is complete. A 
complete path from source to destination(s) exists. 

This status does not appear for OCHNC circuit types.

PARTIAL_TL1 A TL1-created circuit or a TL1-like CTC-created circuit is missing a 
cross-connect, and a complete path from source to destination(s) does not 
exist. 

This status does not appear for OCHNC circuit types.

Purpose This task filters the display of OCHNCs, OCHCCs, OCH trails and 
SONET or SDH circuits in the Circuits page. You can filter the circuits in 
network, node, or card view based on circuit or OCHNC name, size, type, 
direction, and other attributes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Table 7-6 Cisco ONS 15454 Circuit Status (continued)

Status Definition/Activity
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Step 1 Navigate to the appropriate CTC view:

• To filter network circuits, from the View menu choose Go to Network View.

• To filter circuits that originate, terminate, or pass through a specific node, from the View menu 
choose Go to Other Node, then choose the node you want to search and click OK.

• To filter circuits that originate, terminate, or pass through a specific card, double-click the card on 
the shelf graphic in node view (single-shelf mode) or shelf view (multishelf mode) to open the card 
in card view. 

Step 2 Click the Circuits tab.

Step 3 Set the attributes for filtering the circuit display:

a. Click the Filter button.

b. In the General tab of the Circuit Filter dialog box, set the following filter attributes, as necessary:

• Name—Enter a complete or partial circuit name to filter circuits based on the circuit name.

• Direction—Choose one: Any (direction not used to filter circuits), 1-way (display only one-way 
circuits), or 2-way (display only two-way circuits).

• OCHNC Wlen—(DWDM OCHNCs only) Choose an OCHNC wavelength to filter the circuits. 
For example, choosing 1530.33 will display channels provisioned on the 1530.33-nm 
wavelength.

• Status—Choose one: Any (status not used to filter circuits) or Discovered (display only 
discovered circuits). Other statuses do not apply to OCHNCs. 

• State—Choose one: OOS (ANSI) or Locked (ETSI) to display only out-of-service circuits, 
IS (ANSI) or Unlocked (ETSI) to display only in-service circuits (OCHNCs have IS/Unlocked 
states only), or OOS-PARTIAL (ANSI) or Locked-partial (ETSI) to display only circuits with 
cross-connects in mixed service states.

• Protection—Enter the circuit protection type to filter circuits based on their protection.

• Shelf—(multishelf nodes only) Enter the shelf name to filter circuits based on that shelf.

• Slot—Enter a slot number to filter circuits based on the source or destination slot.

• Port—Enter a port number to filter circuits based on the source or destination port. 

• Type—Choose one: Any (type not used to filter circuits), OCHNC (displays only OCHNCs), 
OCHCC (displays only OCHCCs), or OCH-Trail (displays only OCH trail circuits). 

Note The following circuit types are not applicable to DWDM nodes: STS, VT, VT Tunnel, 
STS-V, VT-V, and VT Aggregation Point, VC_HO_PATH_CIRCUIT, 
VC_LO_PATH_CIRCUIT, VC_LO_PATH_TUNNEL, VC_LO_PATH_AGGREGATION, 
VC_HO_PATH_VCAT_CIRCUIT, and VC_LO_PATH_VCAT_CIRCUIT.

• Size—Click the appropriate check boxes to filter circuits based on size. The following sizes are 
available, depending on the circuit type: Multi-rate, Equipment non specific, 2.5 Gbps FEC, 
2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC. 

Note VT1.5, STS-1, STS3c, STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, and STS-192c are not 
applicable to ANSI DWDM nodes. VC12, VC3, VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, 
VC4-8c, VC4-9c, VC4-16c, and VC4-64 are not applicable to ETSI DWDM nodes.
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The check boxes shown depend on the Type field selection. If you chose Any, all sizes are 
available. If you chose OCHNC as the circuit type, only Multi-rate, Equipment non specific, 
2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC appear. If you choose 
OCHCC, only OCHCC is available. If you choose OCH Trail, only Equipment non specific is 
available.

Step 4 To set the filter for the ring, node, link, and source and drop types, click the Advanced tab and complete 
the following substeps. If you do not want to make advanced filter selections, continue with Step 5.

a. If you made selections on the General tab, click Yes in the confirmation box to apply the settings.

b. In the Advanced tab of the Circuit Filter dialog box, set the following filter attributes as necessary:

• Ring—Choose the ring from the drop-down list. 

• Node—Click the check boxes by each node in the network to filter circuits based on node.

• Link—Choose a link in the network.

• Source/Drop—Choose one of the following to filter circuits based on whether they have single 
or multiple sources and drops: One Source and One Drop Only or Multiple Sources or 
Multiple Drops.

Step 5 Click OK. Circuits matching the attributes in the Filter Circuits dialog box appear in the Circuits page.

Step 6 To turn filtering off, click the Filter icon in the lower right corner of the Circuits page. Click the icon 
again to turn filtering on, and click the Filter button to change the filter attributes.

Step 7 Return to your originating procedure (NTP).

DLP-G103 View Optical Channel Circuits on a Span

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), from the View menu choose 
Go to Network View. If you are already in network view, continue with Step 2.

Step 2 Right-click the green line between the nodes containing the circuits that you want to view and choose 
Circuits to view OCHNCs, OCHCCs, or unprotected circuits on the span.

Step 3 In the Circuits on Span dialog box, view information about the circuits that traverse the span. The 
information that appears depends on the circuit type. For OCHNCs, the following information appears:

• Type—The type of circuit: OCHNC, OCHCC, or OCH-Trail.

• Size—The circuit size.

• OCHNC Wavelength—The wavelength provisioned for the OCHNC.

• DIR—2-way or 1-way.

Purpose This task allows you to view OCHNCs, OCHCCs, and OCH trails on an 
ONS 15454 span. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• Circuit—The OCHNC circuit name.

• OCHNC Dir—The direction provisioned for the OCHNC, either Side B-to-Side A or 
Side A-to-Side B.

Step 4 Return to your originating procedure (NTP).

NTP-G184 Create a Provisionable Patchcord

Note If an OTS-to-OTS PPC is created between nodes, it will no longer function if the node Security Mode 
mode is enabled (see DLP-G264 Enable Node Security Mode, page 3-21). The reason for this is that if 
the Secure mode is enabled, it is no longer possible for the DCN extension feature to use the LAN 
interface to extend the internal network (due to the network isolation in this configuration mode). The 
result is that the topology discovery on the OTS-to-OTS PPC no longer operates.

Note This task requires data communications channel (DCC) or GCC connectivity between the OCH node and 
the subtended TXP, MXP, or ITU-T line card client shelves.

Note An optical port requires two patchcords when the remote end is Y-cable protected or is an add/drop 
multiplexer or multiplexer/demultiplexer port.

Note This procedure automatically turns on any OPT-RAMP-C cards installed.

Purpose This procedure creates a PPC, also called a virtual link. Three types can be 
created. The OCH Trunk-to-OCH Trunk or OCH Trunk-to-OCH Filter PPC 
is required by OCHCC circuits when the TXP, MXP, ADM-10G, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, or ITU-T line cards are not 
installed in the same node (in either single or multishelf mode) as the OCH 
(DWDM) cards. PPCs create a virtual connection between the OCH and 
the client nodes. (PPCs are not required for OCHNCs.) 

The OTS-to-OTS PPC is required when nodes do not have OSC 
connectivity. The OTS-to-OTS PPC creates a DCN connection between the 
nodes. For more information about provisionable patchcords, refer to the 
“Circuits and Virtual Patchcords” chapter in the Cisco ONS 15454 DWDM 
Reference Manual.

Tools/Equipment OC-N, TXP, MXP, OADM, ROADM, multiplexer (MUX), and 
demultiplexer (DMX) cards

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the following tasks, as needed, to verify the cabling between the TXP/MXP/line cards in the 
client node and the OCH cards in the DWDM node:

• DLP-G349 Use the Cisco TransportPlanner Internal Connections Report, page 3-69

• DLP-G350 Use the Cisco TransportPlanner Traffic Matrix Report, page 6-26

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Comm Channels > PPC tabs. In network view, click the Provisioning > Provisionable Patchcord 
(PPC) tabs. 

PPCs can be created in either node or network view. However, if you create the PPC in node view, the 
PPC origination ports will be restricted to the cards installed on the node. Therefore, choose node view 
only if you know that the PPC origination port resides on a card installed in the node.

Note You can create OTS-to-OTS PPC only in network view.

Step 3 Click Create. The PPC Attributes page of the PPC Creation wizard appears (Figure 7-9).

Figure 7-9 PPC Creation Wizard — PPC Attributes page

Step 4 Choose one of the following PPC link types. See Table 7-7 for a list of ports that serve as PPC end points 
for each option. 

• Trunk to Trunk (L2)—Creates a PPC between two NNI trunk ports on GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE cards provisioned in L2-over-DWDM mode. 

• Client/Trunk to Client/Trunk—Creates a PPC between two optical channel trunk ports on TXP, 
MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, or ITU-T line cards.

• OTS to OTS—Creates a PPC between two OTS (optical transport section) ports. This option 
establishes DCN connectivity between nodes that do not have OSCM or OSC-CSM cards installed 
and therefore do not have OSC connectivity. OTS ports are selected by CTC after you choose the 
origination and termination sides.
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• OCH Trunk to OCHFilter—Creates a PPC between an optical channel trunk port on a TXP, MXP, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, or ITU-T line card and an optical 
channel filter port on a MUX, DMX, or WSS card.

Table 7-7 Provisionable Patchcord Ports

Card OCH Trunk Port OTS Port OCH Filter Port

TXP cards

MXP cards 

GE_XP

10GE_XP

GE_XPE

10GE_XPE

ADM-10G

OTU2_XP

ITU-T line cards

Any trunk port — —

OPT-BST

OPT-BST-E

OPT-BST-L

— COM RX1

LINE RX

LINE TX

—

OPT-AMP-17-C

OPT-AMP-C

OPT-AMP-L

— COM RX2

COM TX3

LINE RX3

LINE TX3

—

OPT-PRE — COM RX4

COM TX4

—

OSC-CSM — COM RX1

LINE RX

LINE TX

—

32MUX

32MUX-O 

40-MUX-C

— — Any CHAN RX port

32DMX

32DMX-L

32DMX-O

40-DMX-C

40-DMX-CE

— — Any CHAN TX port
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32WSS

32WSS-L

40-WSS-C

40-WSS-CE

— — Any ADD port

40-WXC-C — COM RX

COM TX

—

Table 7-7 Provisionable Patchcord Ports (continued)

Card OCH Trunk Port OTS Port OCH Filter Port
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Step 5 If you chose OCH-Trunk to OCH-Trunk or OCH-Trunk to OCH-Filter in Step 4, complete the following 
fields. If you chose OTS to OTS in Step 4, continue with Step 6. 

• OCHNC Wavelength—(OCH-Trunk to OCH-Filter only) From the drop-down list fields, choose the 
wavelength band (C or L) and wavelength number type (Odd or Even), then choose the wavelength.

• Protected—Check this box if you only want protected cards and ports to appear as options in the 
OCHNC origination and termination pages.

Step 6 Click Next.

Step 7 In the PPC Origination page, complete the fields shown in Table 7-8. The table columns indicate whether 
the field is provisionable based on the option chosen in Step 4.

MMU — EXP A RX

EXP A TX

—

1. Line nodes only

2. When Card Mode is OPT-PRE

3. When Card Mode is OPT-LINE

4. Line nodes with two OPT-PRE cards and no BST cards installed only

Table 7-7 Provisionable Patchcord Ports (continued)

Card OCH Trunk Port OTS Port OCH Filter Port

Table 7-8 PPC Origination Fields

Field Description
OCH-Trunk to 
OCH-Trunk

OCH-Trunk to 
OCH-Filter

OTS to 
OTS

Node Choose the node where the PPC will originate. Yes Yes Yes

Side Choose the side where the PPC will originate. No No Yes

Shelf (Multishelf only) Choose the shelf where the PPC 
will originate.

Yes Yes No

Slot Choose the slot where the PPC will originate. Yes Yes No

Port Choose the port where the PPC will originate. Yes Yes No

Tx Port (Display only) The OTS TX port where the PPC 
will originate.

No No No

Rx Port Choose the RX port where the PPC will originate. No No No

Protection (Display only) Displays the protection option 
chosen in Step 5, if applicable.

No No No

ID Displays the ID automatically assigned to the 
PPC. You can enter a different ID, if needed. 
Patchcord IDs (0 through 32767) are used for 
your internal tracking and to help identify PPCs. 
All IDs must be unique within each node.

Yes No No

Tx ID Displays the transmit ID automatically assigned 
to the PPC. You can enter a different Tx ID, if 
needed, 0 through 32767.

No Yes Yes
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Step 8 Click Next. If you chose OCH-Trunk to OCH-Trunk or OCH-Trunk to OCH Filter with the Protected 
option in Step 4, continue with Step 9. If not, continue with Step 11.

Step 9 In the PPC Protect Termination page, provision the ID field(s). If you chose OCH-Trunk to OCH-Trunk 
in Step 4, one ID field is available. If you chose OCH-Trunk to OCH-Filter in Step 4, two ID fields are 
available, Rx ID and Tx ID.

Step 10 Click Next.

Step 11 In the PPC Termination page, complete the fields shown in Table 7-9. The OCH-Trunk to OCH-Trunk, 
OCH-Trunk to OCH-Filter, and OTS to OTS columns indicate whether the field is provisionable.

Rx ID Displays the receive ID automatically assigned to 
the PPC. You can enter a different Rx ID, if 
needed, 0 through 32767.

No Yes Yes

Reset Resets the ID or Tx ID and Rx ID fields to the 
automatically assigned ID, Rx ID, and Rx ID 
values.

Yes Yes Yes

Table 7-9 PPC Termination Fields

Field Description
OCH-Trunk to 
OCH-Trunk

OCH-Trunk to 
OCH-Filter

OTS to 
OTS

Node Choose the node where the PPC will terminate. Yes Yes Yes

Side Choose the side where the PPC will terminate. No No Yes

Shelf (Multishelf only) Choose the shelf where the 
PPC will terminate.

Yes Yes No

Slot Choose the slot where the PPC will terminate. Yes Yes No

Port Choose the port where the PPC will terminate. Yes No No

Tx Port Choose the TX port where the PPC will 
terminate.

No Yes No

Rx Port Choose the RX port where the PPC will 
terminate.

No No No

Protection (Display only) Displays the protection option 
chosen in Step 5, if applicable.

No No No

ID Displays the ID automatically assigned to the 
PPC. You can enter a different ID, if needed. 
Patchcord IDs (0 through 32767) are used for 
your internal tracking and to help identify PPCs. 
All IDs must be unique within each node.

Yes No Yes

Rx ID Displays the receive ID automatically assigned 
to the PPC. You can enter a different Rx ID, if 
needed, 0 through 32767.

No Yes No

Table 7-8 PPC Origination Fields (continued)

Field Description
OCH-Trunk to 
OCH-Trunk

OCH-Trunk to 
OCH-Filter

OTS to 
OTS
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Step 12 Click Next. If you chose OCH-Trunk to OCH-Trunk or OCH-Trunk to OCH Filter with the Protected 
option in Step 4, continue with Step 13. If not, continue with Step 14.

Step 13 In the PPC Protect Termination page, provision the ID fields. If you chose OCH-Trunk to OCH-Trunk 
in Step 4, one ID field is available. If you chose OCH-Trunk to OCH-Filter in Step 4, two ID fields are 
available, Rx ID and Tx ID.

Step 14 In the PPCs ID page, review the PPC information. If the PPC information is correct, click Finish. If you 
need to make corrections, click Back and return to the wizard page where you want to change the 
information.

Stop. You have completed this procedure.

NTP-G181 Manage GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
Card SVLAN Databases

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node on the network where you will 
manage the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE SVLAN databases. 

Step 2 As needed, complete the following tasks: 

• DLP-G421 Create and Store an SVLAN Database, page 7-61

• DLP-G382 Add and Remove SVLANS to/from GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE NNI 
Ports, page 5-160

Tx ID Displays the transmit ID automatically assigned 
to the PPC. You can enter a different Tx ID, if 
needed, 0 through 32767.

No Yes No

Reset Resets the ID or Tx ID and Rx ID fields to the 
automatically assigned ID, Rx ID, and Rx ID 
values.

Yes Yes Yes

Table 7-9 PPC Termination Fields (continued)

Field Description
OCH-Trunk to 
OCH-Trunk

OCH-Trunk to 
OCH-Filter

OTS to 
OTS

Purpose This procedure creates a service provider VLAN (SVLAN) database for 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards provisioned in 
L2-over-DWDM mode. The procedure stores newly created SVLANs in 
the card (each card has its own SVLAN DB). It also loads and merges 
SVLAN databases into the VLAN DB tab where they can be edited.

Tools/Equipment OC-N, TXP, MXP, OADM, ROADM, multiplexer (MUX), and 
demultiplexer (DMX) cards

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• DLP-G422 Load or Merge an SVLAN Database, page 7-62

Stop. You have completed this procedure.

DLP-G421 Create and Store an SVLAN Database

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > SVLAN > SVLAN DB tabs.

Step 3 In the box next to the Add row(s) button, enter the number of SVLANs you want to create.

Step 4 Click Add row(s).

Step 5 For each SVLAN row, enter the following:

• SVLAN ID—Enter the SVLAN ID. The range is 1 to 4093 with the following restrictions:

– 0 indicates an untagged frame.

– The database can contain a maximum of 4092 unprotected SVLANS. However, it can contain a 
maximum of 1024 protected SVLANs.

• SVLAN Name—Enter the SVLAN name. It can be up to 32 alphanumeric characters.

• Protection—If this is a protected SVLAN, check the Protection checkbox. A maximum of 1024 
SVLANs can be protected.

• MAC Learning—Enables or disables MAC learning for the port. MAC learning is used by Layer 2 
switches to learn the MAC addresses of network nodes so they know where to send traffic. Layer 2 
switches including the GE_XP and 10GE_XP cards in L2-over-DWDM mode maintain a MAC 
learning table that associates the MAC addresses and VLANs with a given port.

Note MAC address table aging is 300 seconds. It cannot be changed. To set this option, the card mode 
must be L2 over DWDM.

• IGMP—Enables or disables the Internet Group Management Protocol (IGMP). By default, IGMP is 
disabled.

• IGMP Fast Leave—Enables or disables the IGMP fast leave. By default, IGMP fast leave is disabled.

• IGMP Suppression—Enables or disables the IGMP report suppression. By default, IGMP 
Suppression is disabled.

Step 6 Click Store.

Purpose This task creates an SVLAN for a network of GE_XP, 10GE_XP, GE_XPE, 
and 10GE_XPE cards provisioned in L2-over-DWDM mode. It then stores 
the SVLAN database on the card and not on the node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 In the Store SVLAN DB dialog box, choose one of the following:

• To Node(s)—Stores the SVLAN database in one or more network nodes. Choose the network nodes 
where you want to store the SVLAN database. 

• Shelf—Appears only when the node is provisioned as a multishelf. Choose the shelf where you want 
to store the SVLAN database.

• Slot—Choose the slot containing the card where the SVLAN database is stored. To choose more 
than one slot, press the Shift key, or click Select All.

• To File—Stores the SVLAN database in a file. Enter a file name, then click Browse to navigate to 
a local or network drive where you want to store the file.

Step 8 Click OK.

Step 9 Return to your originating procedure (NTP).

DLP-G422 Load or Merge an SVLAN Database

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > SVLAN > SVLAN DB tabs.

Step 3 Click one of the following:

• Load—Loads an SVLAN database from the card or local file and replaces any SVLANs that are in 
the network view VLAN DB table.

• Merge—Loads a SVLAN database from the card or local file, but does not replace any SVLANs 
that are in the network view VLAN DB table. The loaded database is merged with any SVLANs that 
might be in the table.

Step 4 In the Load SVLAN DB dialog box, choose one of the following:

• From Node—Loads the SVLAN database from the card. Choose the card where you want to load 
the SVLAN database.

• Shelf—Appears only when the node is provisioned as a multishelf. Choose the shelf where you want 
to load the SVLAN database.

• Slot—Choose the slot containing the card where you want to load the SVLAN database from.

• From File—Loads the SVLAN database from a file. Enter the file path in the blank field, or click 
Browse to navigate to a local or network directory containing the database file. 

Step 5 Click OK.

Purpose This task loads or merges an SVLAN database stored on the card or local 
file into the VLAN DB tab on the CTC network view.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Return to your originating procedure (NTP).

NTP-G60 Create and Delete Overhead Circuits

Note The DCCs, GCCs, and OSCs should not be provisioned between SONET (ANSI) and SDH (ETSI) nodes 
using CTC or TL1 because they cannot operate between SONET and SDH nodes. These communication 
channels should be provisioned on similar nodes, such as SONET-to-SONET or SDH-to-SDH.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you will create the 
overhead circuit. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 7-63.

Step 3 As needed, complete the “DLP-G97 Provision a Proxy Tunnel” task on page 7-66.

Step 4 As needed, complete the “DLP-G98 Provision a Firewall Tunnel” task on page 7-67.

Step 5 As needed, complete the “DLP-G109 Provision Orderwire” task on page 7-69.

Step 6 As needed, complete the “DLP-G110 Create a User Data Channel Circuit” task on page 7-70.

Step 7 As needed, complete the “DLP-G112 Delete Overhead Circuits” task on page 7-71.

Stop. You have completed this procedure.

DLP-G76 Provision DCC/GCC Terminations

Purpose This procedure creates overhead circuits on an ONS 15454 network. 
Overhead circuits include ITU-T GCCs, the AIC-I card orderwire, and the 
AIC-I card UDC.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task creates the DWDM DCC/GCC terminations required for network 
setup when using the TXP, MXP, and OTU2_XP cards. Perform this task 
before you create OCHCC or OCHNC circuits for these cards. In this task, 
you can also set up the node so that it has direct IP access to a far-end 
non-ONS node over the DCC/GCC network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed
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Note For the OTU2_XP card, you can provision the GCC on any ITU-T G.709-enabled port in Transponder 
card configuration and on any port in Standard Regen or Enhanced FEC card configuration. The 
OTU2_XP card supports a maximum of three GCC terminations (on port 3, port 4, and either port 1 or 
2) at a time.

Note The DCCs, GCCs, and OSCs should not be provisioned between SONET (ANSI) and SDH (ETSI) nodes 
using CTC or TL1 because they cannot operate between SONET and SDH nodes. These communication 
channels should be provisioned on similar nodes, such as SONET-to-SONET or SDH-to-SDH.

Step 1 If you are provisioning DCC termination on the TXP and MXP card, set the termination mode of the card 
as appropriate. For details, see the section “Termination Modes” in the chapter “Provision Transponder 
and Muxponder Cards” of Cisco ONS 15454 DWDM Reference Manual.

Step 2 If you are provisioning DCC termination, ensure that the OTN is disabled on OTN interfaces (usually 
trunk ports). If OTN is enabled, provision GCC instead of DCC termination. For more information about 
managing OTN setting on the card, see the procedures for changing card OTN settings in Chapter 5, 
“Provision Transponder and Muxponder Cards”.

Step 3 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Comm Channels > GCC tabs.

Step 4 Select the DCC or GCC tabs as necessary. Available tabs are:

• GCC (both ANSI and ETSI)

• DCC

– SDCC and LDCC (for ANSI)

– RS-DCC and MS-DCC (for ETSI)

Step 5 Click the Create button. The Create Terminations dialog box appears.

Step 6 Select the ports where you want to create the DCC/GCC termination. To select more than one port, press 
the Shift key or the Ctrl key.

Step 7 Under Port Admin State area, select one of the following:

• Leave unchanged—Does not change the DCC/GCC termination port administrative state.

• Set to IS or Set to Unlocked —Puts the DCC/GCC termination port in service.

• Set OOS,DSLBD to IS,AINS (for ANSI) or Set Locked,disabled to 
Unlocked,automaticInService (for ETSI)—Changes a port that is currently out of service or locked 
to automatic in service.

• Set OOS,DSLBD to OOS,MT (for ANSI) or Set Locked,disabled to Locked,maintenance (for 
ETSI)—Changes a port that is currently out of service or locked to out of service for maintenance.

Note For GCC termination, the GCC Rate is set as 192 kbps by default. This rate currently cannot be changed.

Step 8 Verify that the Disable OSPF on Link is unchecked. If this check box is checked, node discovery through 
the link termination will not happen.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 If the DCC/GCC termination includes a non-ONS node, check the Far End is Foreign check box. This 
automatically sets the far-end node IP address to 0.0.0.0, which means that any address can be specified 
by the far end. To change the default to a specific IP address, see the “DLP-G184 Change a DCC/GCC 
Termination” task on page 10-48.

Step 10 In the Layer 3 area, perform one of the following options:

• Check the IP box only if the DCC/GCC is between the ONS 15454 and another ONS node and only 
ONS nodes reside on the network. The DCC/GCC will use Point-to-Point Protocol (PPP).

• Check both the IP box and the OSI box if the DCC/GCC is between the ONS 15454 and another 
ONS node, and third-party NEs that use the OSI protocol stack are on the same network. The 
DCC/GCC will use PPP.

Step 11 If you checked OSI, complete the following substeps. If you checked IP only, continue with Step 12.

a. Click Next.

b. Provision the following fields:

– Router—Choose the OSI router.

– ESH—Sets the End System Hello (ESH) propagation frequency. End system (ES) NEs transmit 
ESHs to inform other ESs and intermediate systems (ISs) about the Network Service Access 
Points (NSAPs) that the ES NEs serve. The default is 10 seconds. The range is 10 to 1000 
seconds.

– ISH—Sets the Intermediate System Hello (ISH) protocol data unit (PDU) propagation 
frequency. IS NEs send ISHs to other ESs and ISs to inform them about the IS NEs that the IS 
NEs serve. The default is 10 seconds. The range is 10 to 1000 seconds.

– IIH—Sets the Intermediate System to Intermediate System Hello (IIH) PDU propagation 
frequency. The IS-IS Hello PDUs establish and maintain adjacencies between ISs. The default 
is 3 seconds. The range is 1 to 600 seconds.

– IS-IS Cost—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the 
cost to calculate the shortest routing path. The default metric cost for LAN subnets is 60. The 
cost normally should not be changed.

Step 12 Click Finish. The following alarms appear until all the network DCC/GCC terminations are created and 
the ports are in service:

• GCC-EOC for GCC termination

• EOC for SDCC termination

• EOC-L for LDCC termination.

Step 13 Return to your originating procedure (NTP).
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DLP-G97 Provision a Proxy Tunnel

Note If the proxy server is disabled, you cannot set up a proxy tunnel. 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > Proxy tabs.

Step 2 Click Create.

Step 3 In the Create Tunnel dialog box, complete the following fields:

• Source Address—Type the IP address of the source node (32-bit length) or source subnet (any other 
length).

• Length—Choose the length of the source subnet mask.

• Destination Address—Type the IP address of the destination node (32-bit length) or destination 
subnet (any other length).

• Length—Choose the length of the destination subnet mask.

Step 4 Click OK.

Step 5 Continue with your originating procedure (NTP).

Purpose This task sets up a proxy tunnel to communicate with a non-ONS far-end 
node. Proxy tunnels are only necessary when the proxy server is enabled 
and a foreign GCC termination exists, or if static routes exist so that the 
GCC network is used to access remote networks or devices. You can 
provision a maximum of 12 proxy server tunnels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

DLP-G76 Provision DCC/GCC Terminations, page 7-63 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G98 Provision a Firewall Tunnel

Note If the proxy server is configured as proxy-only or is disabled, you cannot set up a firewall tunnel. 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > Firewall tabs.

Step 2 Click Create.

Step 3 In the Create Tunnel dialog box, complete the following fields:

• Source Address—Type the IP address of the source node (32-bit length) or source subnet (any other 
length).

• Length—Choose the length of the source subnet mask.

• Destination Address—Type the IP address of the destination node (32-bit length) or destination 
subnet (any other length).

• Length—Choose the length of the destination subnet mask.

Step 4 Click OK.

Step 5 Continue with your originating procedure (NTP).

DLP-G108 Change the Service State for a Port

Purpose This task provisions destinations that will not be blocked by the firewall. 
Firewall tunnels are only necessary when the proxy server is enabled and a 
foreign GCC termination exists, or if static routes cause the GCC network 
to access remote networks or devices. You can provision a maximum of 12 
firewall tunnels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

DLP-G76 Provision DCC/GCC Terminations, page 7-63 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task puts a port in service or removes a port from service. After 
creating an IP-encapsulated tunnel, put the ports that are hosting the 
IP-encapsulated tunnel in service.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note For more information about service states, refer to the “Administrative and Service States” appendix in 
the Cisco ONS 15454 DWDM Reference Manual.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode) on the shelf graphic, double-click the 
card with the ports you want to put in or out of service. The card view appears.

Step 2 Click the Provisioning > Line tabs.

Step 3 In the Admin State column for the target port, choose one of the following from the drop-down list:

• IS (ANSI) or Unlocked (ETSI)—Puts the port in the IS-NR (ANSI) or Unlocked-enabled (ETSI) 
service state. 

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Puts the port in the OOS-MA,DSBLD (ANSI) 
or Locked-enabled,disabled (ETSI) service state. 

For ANSI nodes, traffic is not passed on the port until the service state is changed to IS-NR; 
OOS-MA,MT; or Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS). For 
ETSI nodes, traffic is not passed on the port until the service state is changed to Unlocked-enabled; 
Locked-enabled,maintenance; or Unlocked-disabled,automaticInService.

• OOS,MT (ANSI) or Locked,maintenance (ETSI)—Puts the port in the 
OOS-MA,MT/Locked-enabled,maintenance service state. This state does not interrupt traffic flow, 
but alarm reporting is suppressed and loopbacks are allowed. Raised fault conditions, whether or not 
their alarms are reported, can be retrieved from the CTC Conditions tab or by using the TL1 
RTRV-COND command. Use the OOS-MA,MT/Locked-enabled,maintenance administrative state 
for testing or to suppress alarms temporarily. Change to the IS-NR/Unlocked-enabled or 
OOS-AU,AINS/Unlocked-disabled,automaticInService administrative states when testing is 
complete.

• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)—Puts the port in the 
OOS-AU,AINS/Unlocked-enabled,automaticInService service state. In this state, alarm reporting is 
suppressed, but traffic is carried and loopbacks are allowed. After the soak period passes, the port 
changes to IS-NR/Unlocked-enabled. Raised fault conditions, whether their alarms are reported or 
not, can be retrieved from the CTC Conditions tab or by using the TL1 RTRV-COND command.

Step 4 If you set the Admin State field to IS-AINS or Unlocked,automaticInService, set the soak period time in 
the AINS Soak field. This is the amount of time that the port will stay in the OOS-AU,AINS or 
Unlocked-enabled,automaticInService state after a signal is continuously received. When the soak 
period elapses, the port changes to the IS-NR or Unlocked-enabled state.

Step 5 Click Apply. The new port service state appears in the Service State column.

Step 6 As needed, repeat this task for each port.

Step 7 Return to your originating procedure (NTP).
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DLP-G109 Provision Orderwire

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Overhead Circuits tabs.

Step 3 Click Create. 

Step 4 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Circuit Type—Choose either Local Orderwire or Express Orderwire depending on the orderwire 
path that you want to create. If regenerators are not used between ONS 15454 nodes, you can use 
either local or express orderwire channels. If regenerators exist, use the express orderwire channel. 
You can provision up to four ONS 15454 OC-N/STM-N ports for each orderwire path.

• PCM—Choose the Pulse Code Modulation voice coding and companding standard, either Mu_Law 
(North America, Japan) or A_Law (Europe). The provisioning procedures are the same for both 
types of orderwire.

Caution When provisioning orderwire for ONS 15454 nodes residing in a ring, do not provision a complete 
orderwire loop. For example, a four-node ring typically has Side B and Side A ports provisioned at all 
four nodes. However, to prevent orderwire loops, provision two orderwire ports (Side B and Side A) at 
all but one of the ring nodes.

Step 5 Click Next.

Step 6 In the Circuit Source area, complete the following information:

• Node—Choose the source node.

• Shelf—(Multishelf mode only) Choose the source shelf.

• Slot—Choose the source slot.

• Port—If applicable, choose the source port.

Step 7 Click Next.

Step 8 In the Circuit Destination area, complete the following information:

• Node—Choose the destination node.

• Shelf—(Multishelf mode only) Choose the destination shelf.

• Slot—Choose the destination slot.

Purpose This task provisions orderwire on the AIC-I card. 

Tools/Equipment An AIC-I card must be installed in Slot 9.

An OSCM, OSC-CSM, MXP_2.5_10E, MXP_2.5_10G, 
MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed. 

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Port—If applicable, choose the destination port.

Step 9 Click Finish.

Step 10 Return to your originating procedure (NTP).

DLP-G110 Create a User Data Channel Circuit

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > Overhead Circuits tabs.

Step 3 Click Create.

Step 4 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Type—Choose either User Data-F1 or User Data D-4-D-12 from the drop-down list. 
(User Data D-4-D-12 is not available if the ONS 15454 is provisioned for DWDM.)

Step 5 Click Next.

Step 6 In the Circuit Source area, complete the following information:

• Node—Choose the source node.

• Shelf—(Multishelf mode only) Choose the source shelf.

• Slot—Choose the source slot.

• Port—If applicable, choose the source port.

Step 7 Click Next.

Step 8 In the Circuit Destination area, complete the following information:

• Node—Choose the destination node.

• Shelf—(Multishelf mode only) Choose the destination shelf.

• Slot—Choose the destination slot.

• Port—If applicable, choose the destination port.

Step 9 Click Finish.

Step 10 Return to your originating procedure (NTP). 

Purpose This task creates a UDC circuit on the ONS 15454. A UDC circuit allows 
you to create a dedicated data channel between nodes. 

Tools/Equipment An OSCM, OSC-CSM, MXPP_MR_2.5G, or MXP_MR_2.5G card must 
be installed. 

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G112 Delete Overhead Circuits

Caution Deleting overhead circuits is service affecting if the circuits are in service (IS). To put circuits out of 
service (OOS), see the “DLP-G108 Change the Service State for a Port” task on page 7-67.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Overhead Circuits tabs.

Step 3 Click the overhead circuit that you want to delete: local or express orderwire, user data, IP-encapsulated 
tunnel, or DCC tunnel.

Step 4 Click Delete.

Step 5 In the confirmation dialog box, click Yes to continue.

Step 6 Return to your originating procedure (NTP).

NTP-G62 Create a J0 Section Trace 

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you will 
create the section trace. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP or MXP card.

Purpose This task deletes overhead circuits. Overhead circuits include 
IP-encapsulated tunnels, AIC-I card orderwire, and UDCs.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to traffic between nodes. 

Tools/Equipment One TXP or MXP card must be installed.

Prerequisite Procedures NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, ADM-10G, and OTU2_XP Cards, page 3-60

DLP-G223 Change the 4x2.5G Muxponder Line Settings, page 5-93 (if 
necessary)

DLP-G224 Change the 4x2.5G Muxponder Section Trace Settings, 
page 5-95

Required/As Needed As needed (optional if path trace is set)

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Click the Provisioning > Line > Section Trace tabs.

Step 4 From the Port drop-down list, choose the port for the section trace.

Step 5 From the Received Trace Mode drop-down list, enable the section trace expected string by choosing 
Manual.

Step 6 In the Transmit Section Trace String Size area, click 1 byte or 16 byte. The 1 byte option allows you to 
enter one character and the 16 byte option allows a 15 character string.

Step 7 In the New Transmit String field, enter the string that you want to transmit. Enter a string that makes the 
destination port easy to identify, such as the node IP address, node name, or another string. If the 
New Transmit String field is left blank, the J0 transmits a string of null characters.

Step 8 If you set the Section Trace Mode field to Manual, enter the string that the destination port should receive 
from the source port in the New Expected String field. 

Step 9 If the card's Termination mode is set to Line, click the Disable AIS and RDI if TIM-P is detected check 
box if you want to suppress the alarm indication signal (AIS) and remote defect indication (RDI) when 
the STS Section Trace Identifier Mismatch Path (TIM-P) alarm appears. If the card's Termination mode 
is set to Section, the Disable AIS and RDI if TIM-P is detected check box will be grayed out and you 
will not be able to select it. Continue on to Step 10. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide for descriptions of alarms and conditions.

Step 10 Click Apply.

Step 11 After you set up the section trace, the received string appears in the Received field. The following 
options are available:

• Click Hex Mode to display section trace in hexadecimal format. The button name changes to ASCII 
Mode. Click ASCII Mode to return the section trace to ASCII format.

• Click the Reset button to reread values from the port. 

• Click Default to return to the section trace default settings (Section Trace Mode is set to Off and the 
New Transmit and New Expected Strings are null).

Caution Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The expect and receive strings are updated every few seconds.

Stop. You have completed this procedure.

NTP-G203 Create End-to-End SVLAN Circuits

Purpose This procedure manually creates an end-to-end SVLAN circuit for the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards provisioned in 
L2-over-DWDM mode.

Tools/Equipment None
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Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits > SVLAN tabs. 

Step 3 Click Create.

Step 4 Define the circuit attributes:

• Name—Assign a name to the source SVLAN circuit. The name can be alphanumeric and up to 48 
characters (including spaces). If you leave the field blank, CTC assigns a default name to the source 
cross-connect.

• Type—(Display only) SVLAN.

• SVLAN ID—Displays the SVLAN identifier. Enter a SVLAN ID between 1 and 4093. Do not 
duplicate SVLAN IDs.

• Protection—Before enabling SVLAN protection be sure to define the master node in the OCHRing 
that contains the circuit. Protection must be enabled in order to have a SVLAN protected circuit 
provisioned. 
Check/uncheck to enable/disable SVLAN protection. 1024 SVLANs can be protected. 

Step 5 Click Next.

Step 6 Provision the circuit source (UNI only):

a. From the Node drop-down list, choose the circuit source node. 

b. From the Slot drop-down list, choose the slot in the GE_XP, 10GE_XP, GE_XPE or 10GE_XPE card 
that must be used in the circuit.

c. From the Port drop-down list, choose the port to be used by the circuit.

Step 7 Click QinQ Settings. Provision the IEEE 802.1QinQ VLAN tags on the GE_XP, 10GE_XP, GE_XPE 
or 10GE_XPE cards. See the “DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
QinQ Settings” task on page 5-163.

Step 8 Click Next.

Step 9 Provision the circuit destination (UNI only):

a. From the Node drop-down list, choose the circuit destination node.

b. From the Slot drop-down list, choose the slot to be used by the circuit.

c. From the Port drop-down list, choose the port to be used by the circuit. 

Step 10 Click QinQ Settings. Provision the IEEE 802.1QinQ VLAN tags on the GE_XP, 10GE_XP, GE_XPE, 
and 10GE_XPE cards. See “DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
QinQ Settings” task on page 5-163.

Step 11 Click Next.

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card 
Mode, page 5-7

DLP-G421 Create and Store an SVLAN Database, page 7-61

NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 7-16

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 12 The SVLAN Circuit Routing Preview pane provides the following information:

• SVLAN Circuit Path—Nodes and spans. Click a node to select it. Blue arrows show the new SVLAN 
route. Move your cursor over the arrow to view span information including source, destination, and 
span loss information.

• Selected Node—Node that is currently chosen in the graphic. All actions that are invoked will apply 
to this node.

• Included Nodes—Nodes that are included in the circuit path.

• Excluded Nodes—Nodes that are excluded from the circuit path. 

• Include—Includes the node displayed in the Selected Node field in the circuit path. Click Apply to 
update the circuit with the new constraints. This option is not applicable for protected SVLAN 
circuits.

• Exclude—Excludes the node displayed in the Selected Node field from the circuit path.Click Apply 
to update the circuit with the new constraints. This option is not applicable for protected SVLAN 
circuits.

Step 13 Click Finish to complete the circuit creation.

Step 14 To edit the SVLAN circuit, see instructions described in the “DLP-G472 Edit the End-to-End SVLAN 
Circuit” section on page 7-74.

Stop. You have completed this procedure.

DLP-G472 Edit the End-to-End SVLAN Circuit

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits > SVLAN tabs.

Step 3 Select the SVLAN circuit that you want to edit and click Edit.

The Edit Circuit pane appears. 

• Use the General tab to view circuit information (circuit type, size, protection type, and routing 
preference), and to modify the circuit name.

• Use the End Points tab to view and define new circuit drops for the SVLAN circuit. 

Step 4 Return to your originating procedure (NTP). 

Purpose This task edits an end-to-end SVLAN circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G229 Provision DCN Extension for a Network Using 
GCC/DCC

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network (for example, Node 
A) where you want to provision the DCN extension. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G105 Provision Optical Channel Network Connections” task on page 7-23, to create 
an OCHNC DCN circuit for the wavelength of the transponder (TXP) to be used for the GCC channel.

Step 3 Complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 7-63, to create a GCC service 
channel on the transponder in Node A.

Step 4 Complete the “DLP-G46 Log into CTC” task on page 2-26 at another node on the network (for example, 
Node B) where you want to provision the DCN extension. 

Step 5 Complete the “DLP-G105 Provision Optical Channel Network Connections” task on page 7-23, to create 
an OCHNC DCN circuit for the wavelength of the transponder to be used for the GCC channel.

Step 6 Complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 7-63, to create a GCC service 
channel on the transponder in Node B.

Step 7 Turn up the circuit by forcing an ALS manual restart on the line-facing amplifier:

a. Double-click the line-facing amplifier card

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Manual Restart.

d. Click Apply. Click Yes in the confirmation dialog box.

Step 8 When the circuit is up, CTC discovers the GCC topology and shows the two nodes (Node A and B) 
connected by the GCC link.

Step 9 Complete the “NTP-G184 Create a Provisionable Patchcord” task on page 7-54, to create an 
OTS-to-OTS PPC between the two nodes.

Step 10 Complete the “DLP-G472 Merge two OCHNC DCN Circuits” task on page 7-76, to merge the two 
OCHNC DCN circuits into a single OCHNC circuit.

Stop. You have completed this procedure.

Purpose This procedure provisions a DCN extension for a network using GCC/DCC 
as the communication channel

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G472 Merge two OCHNC DCN Circuits

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab.

Step 3 Select one of the OCHNC DCN circuits that you want to merge and click Edit. The Edit Circuit pane 
appears.

Step 4 Click Merge tab.

Step 5 Select the other OCHNC DCN circuit that you want to merge and click Merge. 

Step 6 Return to your originating procedure (NTP). 

Purpose This task merges two OCHNC DCN circuits into a single OCHNC circuit

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
7-76
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